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10Learning About this Resource
How to Use This Guide

Welcome to Denali by Cougar Mountain Software. This guide is designed to help you 

effectively learn and use the Purchase Order module. This chapter introduces you to 

the information contained in the guide. 

How to Use This Guide
We wrote this documentation to accommodate a system that has all available modules and 
enhancements installed and integrated. If this is not the case, some windows and options might be 
different. After you review this guide, if you would like to expand your software package to get the most 
out of Denali, refer to our website or contact our Sales Department at (800) 388-3038 for more 
information.
If you have not done so already, we highly recommend you review the information in the Getting Started 
guide before you continue. This guide provides valuable information on the commonalities between the 
Denali modules, customization options to ensure Denali meets your needs, and overviews of the 
different types of help and training available.

How This Guide Is Organized
Refer to this section for a summary of what is covered in this user’s guide and how to get the most out 
of it.

Chapter 1: Learning About this Resource
This chapter introduces you to the organization of this user’s guide. It provides an overall look at the 
information you can find and how it is designed.

Chapter 2: Setting Up the Purchase Order Module
Setting up your module is one of the most important things to do to ensure you get the most from your 
software. This section covers the general setup, integration with other modules, printing preferences, 
and codes used in Purchase Order.

Chapter 3: Entering Purchase Orders
In this section, we provide you with information about entering or editing purchase orders. This includes 
changing vendor address information or adding items to an order from history. You will also find 
information on generating orders based on inventory levels.

Chapter 4: Entering Requisitions
In this section, we provide you with information about entering, editing, and approving purchase orders. 

Chapter 5: Receiving Purchase Orders
This section provides information about receiving items in a purchase order. The information covers 
how you can receive partial orders, receive entire orders, or invoice orders. It also includes how to add 
items to an existing order when receiving it and how to track your landing costs.

Chapter 6: Purchase Order Management Tasks
There are times when certain tasks are handled by management personnel only. In This section we 
discuss tasks such as pre-issuing purchase order numbers, entering returns, correcting errors in 
transactions, posting receiving transactions, and purging unwanted history from the system.

http://www.cougarmtn.com
ACTPOSMaster.chm/contact_information.htm
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Chapter 7: Working With Reports in Purchase Order
In this section, we cover the reports available to help you track ordering information.

Chapter 8: Quick Access in Purchase Order
This section is a great resource for learning about the shortcuts, hot keys, and quick accessibility 
options that are available in the Purchase Order entry windows. It also provides a quick reference of the 
right-click menu options that can help streamline your entry process.

Chapter 9: Additional Resources
This section provides information on format requirements you must use to import and export data in 
Purchase Order. You will also find calculations the system uses for the various fields in the PO Entry 
windows, a glossary of accounting terms, and information to help you format user-defined fields.

Denali Help 
Cougar Mountain Software is dedicated to providing as much help as you need to feel comfortable using 
our software. These topics describe the conventions we use in the documentation and the different 
types of help we offer.

Document Conventions
The following conventions are used throughout the documentation: 

Convention Use

Bold Titles, names, and anything that appears on the screen will appear in bold, 
exactly as it appears. 

•Select Change Session Date from the Common Tasks 
menu.
•Click the New button.
•Enter a name in the Name box.

Italic Italics are used for text that you should enter, or text that appears in a box 
or field within a window.

•Enter Hardwood in the Description box.
•The default for this field is IN Code.

Uppercase Uppercase characters will be used to denote keyboard keys or hot key 
combinations. Some examples are:

•To delete an item in the detail grid, select the item and 
press the DELETE key.
•To open the Enter Transaction Comments window, 

simultaneously press SHIFT+C.
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In-Program and Web Help
Cougar Mountain offers in-program help, which is part of the software, accessible from any Help button, 
and does not require an Internet connection. We also offer web help that you can access at https://
cougarmtnservice.com/help/index.html. The web help includes features not available in the in-
program help, such as the ability to comment on topics and share information on social networking 
platforms. The content is the same in the in-program and web help. 
When you access the help, you will find we offer both procedural and window-specific help. If you want 
to know the steps you need to take to complete a task, you should access the procedural help. If you 
want to know what an option or field in a window is used for, you should access the window-specific 
help. 

Window-Specific Help
Denali offers window-specific help that explains each field and option available in every window. When 
you work in the software, you can access help specific to an active window or tab when you click the 
Help button or press F1 on the keyboard.
In many window-specific topics, you can access related task-based help topics when you select the See 
Also button at the bottom of the topic window. You can also access the task-based help from the Table 
of Contents in the left pane of the Help window. 

Procedural Help
Procedural help gives you steps to complete a process from start to finish and general information about 
the software windows. You can access this help from the left navigation pane in the software when you 
click Resources and Tools > Access the Denali Help. You can also access the Help when you select 
the question mark on the right side of the toolbar. If you already have the Help window open, you can 
access all the help from the Table of Contents in the left pane of the window.

Reference Help
Denali includes topics that are designed to provide additional information for your reference. For 
example, format requirements to import transactions and purchase order calculations. Most of these 
topics can be found in the Appendix, which you can access from the Table of Contents in the in-program 
and web help. 

Navigating the In-Program Help
When you access the Help in the software, you access the in-program help system. To help you find the 
information you’re looking for, we outline the different parts of the Help window. 

> This character is used to separate menus, submenus, and commands. 

For example: Select Renumber / Merge Stock Items from the Inventory 
Items menu is written as: Select Inventory Items > Renumber / Merge 
Stock Items from the left navigation pane.

Convention Use
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Figure 1: Navigational points and features available in the in-program help window.

The reference numbers in the table correspond with the previous figure and are used to highlight the 
main navigational points and features.  

Reference 
Number

Option Name Description

1 Contents tab This is the Table of Contents for the Help. Click on the books to show 
the related subtopics.

2 Breadcrumbs These are links that show you where you are in the Help. The first link 
reflects the main topic and following links are subtopics. You can click 
these links to navigate backwards.

3 Hide button This hides the Table of Contents and changes to read Show, which you 
can then click to see the Table of Contents.

4 Back button Clicking this button takes you back through the previously viewed topics 
one at a time.

5 Forward button Clicking this button takes you forward through the topics you have 
moved back through using the Back button, one topic at a time.

6 Home button This button returns you to the main topic window in the Help.

7 Print button If you want to print the current help topic, click this button.

8 Website button This button opens the Cougar Mountain corporate website through your 
browser.

9 Topic window This window displays the open or active topic.

10 Sublinks The links listed are subtopics of the open topic.
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Navigating the Web Help
To help you find the information you’re looking for in the web help, we outline the different parts of the 
window. 

Figure 2: Navigational points and features available in the web help window.

The reference numbers in the table correspond with the previous figure and are used to highlight the 
main navigational points and features. 

11 Email Us Your feedback on the documentation and Help systems is appreciated. 
Use this email address to send the Documentation Team your 
comments or suggestions.

Reference 
Number

Option Name Description

1 Contents This is the Table of Contents for the Help. Click on the folders to show 
the topics available.

2 Search Use the search field to quickly find the information you’re looking for. 
You can use the drop-down to filter the search to certain modules/
guides.

3 Forward and 
Back 

Click these arrows to navigate forward and back through the help 
topics, one topic at a time.

4 Home Click this button to go to the home page of the web help.

5 Translate Click this button to translate the help to another language.

6 Breadcrumbs These links show you where you are in the help. The first link reflects 
the main topic and the following links are subtopics. You can click these 
links to navigate backwards.

Reference 
Number

Option Name Description
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Printing Help Topics
You can print out any help topic to keep for future reference. 
To print a single topic:

1 Select the Print button or right-click and select Print from the right-click menu.
2 If the Print Topics window appears, select Print the selected topic and then select OK.
3 When the Print window appears, make any desired adjustments and then select Print.

To print multiple topics in the in-program help:
1 Verify the Contents tab is visible.
2 Highlight the heading of the section you would like to print.
3 Select the Print button.
4 The Print Topics window will appear.
5 Select Print the selected headings and all subtopics to print the entire section.

User Guides
Denali includes access to PDF (portable document format) versions of the procedural help that you can 
open with Acrobat® Reader®. This is the same procedural help content that appears in the in-program 
and web help. To access these user guides, click Start > Denali by Cougar Mountain > Denali User 
Guides. When the Customer Service Center site opens, choose the guide you want to view. 

Release Notes
The Release Notes include last-minute changes and technical issues not covered in other 
documentation. You can review the Release Notes on the installation screen at the start of the 
installation process, from the Start menu, or through the web help. You need to have Acrobat® Reader® 
to view the PDF. 
To access them from the Start menu, click Start >Denali by Cougar Mountain > Release Notes. 

7 Social Click these buttons to post a topic on social media.

8 Print & Email Click these buttons to print the help topic or email the CMS 
Documentation team. 

9 Sublinks The links listed are subtopics of the open topic.

10 Disqus Comment Use this feature to share public comment/questions with other users 
and the CMS Documentation team.

Reference 
Number

Option Name Description
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Customer Support
If you come across a problem or an error message you cannot resolve, call our Customer Support 
Department. Cougar Mountain Software maintains a full-time Customer Support staff at our Boise, 
Idaho office specially trained to solve problems.
Our Customer Support staff has the expertise to answer your questions about installation and operation 
of the software. Call (800) 390-7053 to contact a Support Specialist. You can receive customer support 
over the phone from Cougar Mountain Software or you might be referred to a Cougar Mountain 
business partner in your area who can provide personalized, local support. 
Cougar Mountain Software offers support contract plans that allow you to get help when you need it. 
You can request a Customer Support Specialist to contact you through our online form or you can send 
an email to Customer Support. Visit our Customer Support Center online at: https://
www.cougarmtn.com/support-request/.
You can also visit the customer service site at https://service.cougarmtn.com to search for software 
updates you can download at your convenience. 

Information to Gather before You Contact Customer 
Support
When you contact Cougar Mountain Customer Support, please have your support number ready. This 
is typically your telephone number with the area code first. It will also be helpful to know your operating 
system, the Cougar Mountain product(s) you purchased and installed, and the version of the product. If 
you are not sure how or where to find this information, Customer Support can help.

Contacting Customer Support
Refer to the following table for options available to contact a Customer Support Specialist for answers 
to your questions. You can also use one of these options to purchase a support contract, which will 
ensure you get the help you need. 

Training
While Denali is a comprehensive business accounting solution, the information you can get from the 
software will only be as good as the information you put in. The more you know about the software, the 
more you will be able to take advantage of its features. For this reason, we consider training to be a 
critical part of the learning process. We offer several different types of training—one or more are sure 
to meet your educational needs, time constraints, and budget. Contact Cougar Mountain at (800) 388-
3038 about your training needs.

Support Type: Contact via:

Contact a Customer Support Specialist. (800) 390-7053

Purchase a Software Assurance plan. (800) 388-3038

Email questions to a Customer Support 
Specialist.

technicalsupport@cougarmtn.com

Complete the online Call Back Request form to 
have a Customer Support Specialist contact you.

https://www.cougarmtn.com/support-
request/

https://www.cougarmtn.com/supportForm.asp
https://service.cougarmtn.com
mailto: technicalsupport@cougarmtn.com
https://www.cougarmtn.com/support-request/
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Online Training
To ensure you get the most out of your accounting software, it is important that you understand all its 
capabilities. For this reason, as part of our Software Assurance program, we include the opportunity for 
you to participate in e-learning. This educational resource is offered online through the Cougar Mountain 
Customer Service Center (CSC) website (https://service.cougarmtn.com/). Depending on the 
subscription you purchase, you can access a wealth of short presentations on the features of Denali. 
Because these presentations are online, you can view a topic whenever it is convenient for you and/or 
your employees. For more information on this resource, contact your account executive at (800) 388-
3038.

Classroom Training in Boise
We offer training classes on a regular basis at our corporate headquarters in beautiful Boise, Idaho. If 
you have a few people to train, this is a great way to learn about the software’s features and how you 
can use it to its full potential for your needs. One of the benefits of coming to our training classes is that 
you can hear from other users of the software, which can remind you of issues that are important to you. 
Another benefit is that it removes you from the day-to-day tasks at your own office and allows you to 
concentrate more fully on learning how to use the software. You can use this as a powerful tool to “train 
your trainer”—once the staff members who attended the training arrive back home, they can teach other 
staff members the aspects of the software they need to know.

On-Site Training at Your Business
If you have more than a few people to train, you might want to consider on-site training. In this scenario, 
one of our professional trainers travels to your site and works with your employees. One advantage to 
this type of training is that you can train as many people as necessary without incurring additional costs 
and you can have specific people participate for specific sessions depending on their job duties. For 
example, during the training for Purchase Order, only those associated with handling purchase orders 
need to be present. This will allow for less interruption in daily productivity. Another advantage of on-
site training is that you can work with your own organization’s data and business practices while 
focusing on the specific needs of your business.

Telephone Training
Training can also be done over the telephone. Using network streaming technology via an internet 
connection between your computer and our trainer’s computer, you and your employees can work with 
one of our professional trainers to focus on the specific parts of the software you choose. The trainer 
will be able to see your computer screen and you can work with either your own data or the 
demonstration data to learn how to best use the software for your business. This is a great solution if 
you have one or two modules that are new to you and you want thorough training without traveling to 
our training facility or having a trainer come to you.

Training Videos
Cougar Mountain Software also offers training videos which can help you in specific areas of the 
software. They serve as a great orientation for people new to your company and/or the software. They 
also can be a refresher for people who have already used the software, but need help in a few areas or 
are changing their job responsibilities to include things they haven’t done before.

https://service.cougarmtn.com


18Learning About this Resource
Troubleshooting Options

Troubleshooting Options
One goal of Cougar Mountain Software is to make your accounting software experience a positive and 
effective one. For this reason, we included Troubleshooting sections throughout this documentation to 
provide answers to problems that might occur. It is our intent to provide many possible solutions to your 
questions. If you have suggestions for additions to the Troubleshooting sections, please feel free to 
email us at documentation@cougarmtn.com. 

mailto:documentation@cougarmtn.com
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Options and Preferences in Purchase Order

Setting up Purchase Order is a process of defining your options, preferences, and 

codes. You can choose how you want Purchase Order to be integrated with other 

modules, set up any customized fields you want to include, and customize the layout 

of the entry and receiving windows. This chapter provides intial setup instructions and 

information for setting up Purchase Order.

Options and Preferences in Purchase Order
Every module has features and flexibility that allow you to customize the module to meet your needs. 
This is not intended as a comprehensive explanation of all your options, but we present some choices 
that you should make before you begin. We also show you where you can define these different options 
and introduce you to some basic functionality of the module. 
To set up the Purchase Order module, you need to define preferences such as sharing information with 
other modules, defining module defaults, and setting up landing, if applicable to your business. These 
settings and options are found in the PO Module Preferences window that you can access by selecting 
Options > Set Up the Module Preferences from the left navigation pane. You can select the Help 
button in a window for detailed information on all of the available fields and options. 

General Setup
On the General tab, you can choose to use multiple batches and/or multiple users in each batch. If you 
allow multiple users per batch, then you must use online purchase order numbering. If you want to pre-
issue purchase order numbers, you cannot use online numbering and therefore can only have one user 
in a batch at a time. For more information on pre-issuing purchase order numbers, see “Pre-Issuing 
Purchase Order Numbers” on page 76.
You can choose to include a signature line on all of your printed purchase orders. Select the Print 
signature line on purchase orders check box if signatures are part of your entry or approval process. 
You can also choose to alert your buyers when the cost of an item increases from when it was previously 
purchased by selecting the Show alert when cost increases check box.
If you want to be able to post encumbered transactions when you enter them, select the Enable 
encumbering check box. This activates options on the Purchasing menu that allow you to set up and 
select batches, view an edit report, and post.
The Open Purchase Order Method drop-down field allows you to control how purchase orders are 
handled after they’ve been saved. For example, if you select the All Purchase Orders are Closed option, 
you can ensure that once a purchase order is entered and saved, it will not be edited. 



21Setting Up the Purchase Order Module
Options and Preferences in Purchase Order

Figure 3: PO Module Preferences window

Working with Batches in Purchase Order
On the General tab of the PO Module Preferences window, you can select whether or not you want to 
use multi-batch mode when you receive purchase orders. You should select the Multi-batch mode 
check box if you want to store transactions in different batches so you can post them at different times. 
For example you might want to set up a batch for partially received purchase orders or you might want 
to set up a specific batch for each day of the week on which transactions are received. For more 
information on working with batches see “Transaction Batches” in the Getting Started guide.
You also have the option to use multiple batches when you enter purchase orders if you select the 
Enable encumbering check box in Module Preferences. When you select this, you can post 
encumbered transactions when you enter them. You can also place encumbrance transactions on hold 
and have multiple active batches that contain encumbrances until you are ready to post them. 
If you want to allow multiple users to access the same receiving batch at the same time, select the 
Multiple users per batch check box on the General tab of Module Preferences. If you leave this option 
unchecked, only one person at a time can enter receiving transactions into a batch. As a security 
feature, you might want to leave the default of unchecked and only allow the user who set up the batch 
to process transactions in it. 

Setting Up Batches 
If you are using multi-batch mode, you can set up as many batches as necessary to meet the needs of 
your business (see “Transaction Batches” in the Getting Started guide). By considering all the ways you 
might use batches, you can determine an effective naming scheme. For example, you might include the 
clerk’s initials, the day of the week, and the date in the batch name for future reference. Keep in mind 
that when you post a batch, the batch will clear and become unavailable.
To set up a new receiving or purchasing batch:

1 In Purchase Order, select Receiving Tasks > Set Up a New Receiving Batch from the navigation 
pane or the New button in the PO Select Receiving Batch window 
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- or - 
In Purchase Order, select Purchasing Tasks > Set Up a New Purchasing Batch from the navigation 
pane or the New button in the PO Select Purchasing Batch window.
The PO Set Up Batch window will open.

Figure 4: PO Set Up Receiving Batch window

2 Enter a unique identity for this new batch, or accept the default that includes the user name and time 
the batch was created. The identity you set up will not appear on any reports. 
The information for the batch number, the date the batch was created, and the number of transactions 
is autogenerated by the system and cannot be edited. 

3 Select Save to keep this new batch. 
When you post activity using this batch, the autogenerated batch information shown in certain reports 
includes the module from which the activity is generated, the activity number, and the batch number. 
For example, the posting reference for the batch shown in the image in this section would appear 
something like PO000004565AAAAAA on the posting reports. 

Setting Up Purchase Order Landing 
Tracking landing costs allows you to account for acquisition costs in the final cost of an item. Because 
each vendor might have a different charge for freight and tax, and offer a different discount, tracking 
landing might help you decide from which vendor to order items. On the General tab of the PO Module 
Preferences window, you can define your default landing options. You can also specify to what items 
landing costs apply, whether freight, tax, and discounts are included in landing costs, and what type of 
landing method to use. 
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Figure 5: PO Module Preferences window, Landing section

If your business process does not include tracking landing, select None from the Items to Land drop-
down. You can also choose to land Inventory items or all items on your order. If you choose to land 
items, you can then select from the Landing Method drop-down list if you want the landing costs to be 
distributed evenly across all items that have landing applied, or only on items you manually select.
The selections you make in this window determine what options appear and how landing is handled in 
the entering and receiving windows. For example, in order for the Land Item check box to appear in the 
PO Enter Purchase Orders window, you must select Inventory or All Lines from the Items to Land drop-
down list and choose Select Items to Land from the Landing Method drop-down. 

Purchase Order Relationship with Other Modules
Integration is the way information is shared between installed modules. If you integrate, information can 
be automatically sent to General Ledger, Accounts Payable, and Inventory when you post. You can also 
look up information from these modules. See “The Lookup Feature” in the Getting Started guide for 
more information.

For example, if Purchase Order is integrated to Inventory, you have access to stock item information 
while you enter purchase orders, and stock item totals are immediately updated when you post. If you 
choose to integrate Purchase Order to Accounts Payable, you can access vendor information while you 
enter purchase orders, and Accounts Payable totals are immediately updated when you invoice and 
post received items. You can set integration on the Integration tab of the PO Module Preferences 
window.

NOTE:  If you receive an error indicating integration failed, print the generated report, 
make the corrections listed, reopen Module Preferences, and select the Fix 
<Module> Integration button on the Integration tab.
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Figure 6: Purchase Order’s integration to other modules. 

Setting Up Other Purchase Order Defaults
On the Defaults tab, there are several defaults you can define to meet the needs of your business. 
If you selected the Online purchase order numbering check box on the General tab, enter the 
purchase order number from which you want to start incrementing in the Last Purchase Order Number 
field. Choosing this method of numbering eliminates the possibility of duplicate purchase order 
numbers. If you use alpha characters in your purchase order numbers, we highly recommend that you 
end your numbers with a numeric character to increment by. 

Figure 7: PO Module Preferences window, Defaults tab

You can also choose your default Purchasing Buyer and Receiving Buyer (see “Setting Up Your Users 
(Buyer Codes)” on page 33 for more information on setting up Buyers), which you can override later in 
the entry windows if necessary. For detailed information on the options in this window, select the Help 
button in the software. 
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Tracking User-Defined Order Information
On the User-Defined Fields tab of the PO Module Preferences window, you can set up customized 
fields that track information of your choice. You can create Header user-defined fields, which will track 
information for the entire purchase order, or Detail user-defined fields, which will track information for a 
specific line item. You can also use these fields as filters on some reports.
To set up user-defined fields:

1 Select Options > Establish User-Defined Tracking from the navigation pane. The PO Module 
Preferences window will open. 

2 On the User-Defined Fields tab, click the Add or Edit User-Defined Fields button. The PO Add or 
Edit User-Defined Fields window will open. 

Figure 8: PO Add or Edit User-Defined Fields window

3 In the PO Add or Edit User Defined Fields window that appears, set up the type of UDFs you want to 
use. You can select a Text Field Type and check the Lookup/Code check box to create a user-
defined Code for which you can define specific Codes to enter in that field.
For detailed information on the fields in this window, select the Help button in the software. See 
“Formatting User-Defined Fields” on page 115 for the characters you can use to define your UDFs.

4 Select OK to return to Module Preferences.
5 From the Header user-defined fields and Detail user-defined fields Lookups in Module 

Preferences, you can select which UDFs you want to appear and in what order. 
6 When you are finished setting up your UDFs, select OK.

For information about using these fields after setup, see “Using the User-Defined Fields After Setup” on 
page 28. To define codes for the Code type UDFs, see “Setting Up User-Defined Codes” on page 37.
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Purchase Order Printing Preferences
Set your printing preferences on the Print Options tab. The types of printing you can specify are for 
purchase orders, posting reports, and any other reports printed from the module. You can select the 
output type, number of copies, format, and printer/file name for each type of report. Use the Edit check 
box to specify whether or not you want the ability to edit these preferences each time you print a report. 
For example, if you sometimes want to preview a report on the screen before printing it, select the Edit 
check box. After previewing the report, you can then choose to print the report to a printer, to a file, or 
select Cancel.
To learn more about printing reports in Denali, see “Reporting Overview” on page 89. 

Defining Your Purchase Order Screen Layouts
By customizing the PO Enter Purchase Orders and PO Receive Items windows, you can control what 
information your buyers can view or edit when they enter, receive, or invoice orders. It’s important to 
become familiar with the different elements in the entering and receiving windows and how customizing 
these elements can act as a security control for you. Because you can attach the screen layouts you 
set up to different Buyer Codes, you can allow certain buyers to have rights to view and edit information 
that other buyers may not have. For example, if you don’t want a buyer to be able to change item prices, 
you can make the cost fields informational only or hide them for that layout. You can also customize 
these screens to specifically meet the needs of your business and processes. For instance, you can 
modify the field labels to be the same as your preprinted purchase orders or to use your company’s 
terminology. You can even set up the tab order of the fields in the windows to help increase efficiency. 

Overview of the Entry Window
The PO Enter Purchase Orders window is broken into four sections. Each section contains different 
information and the tabs in the layout window allow you to customize what your buyers will see or be 
able to edit in each section. The image and table in this section will help you understand which parts of 
the entry window will be affected by the preferences you set on each tab in the PO Set Up Purchasing/
Receiving Layout window. 
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Overview of the Receiving Window
The PO Receive Items window can be broken into five sections. Each section contains different 
information and the tabs in the layout window allow you to customize what your buyers will see or be 
able to edit in each section. The image and table in this section will help you understand which parts of 
the receiving window will be affected by the preferences you set on each tab in the PO Set Up 
Purchasing/Receiving Layout window.

Figure 9: PO Receive Purchase Orders window

Reference 
Number

Window Section Section Purpose

Vendor / Shipping 
Information

The fields in this section of the window are used to display 
and enter vendor and shipping information. See “Defining 
Vendor Information” on page 30 for information on setting 
up the layout of this section. 

Header Information The fields in this section of the window are used to enter 
and display information about the entire transaction. Refer 
to “Defining Header/Receiving Information” on page 30 for 
additional information on setting up the layout of this 
section.

Detail Information The fields in this section of the window are used to enter 
the items for the purchase order. For additional information 
on setting up the layout of this section, see “Defining Detail 
Information” on page 31.

Transaction Totals The fields in this section of the window reflect the various 
running totals pertaining to the current transaction. 
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Using the User-Defined Fields After Setup
If you defined any user-defined fields on the User-Defined Fields tab of the PO Module Preferences 
window, those fields appear in the Set Up Purchasing / Receiving Layout window so you can add 
them to your purchasing and receiving windows. You can add fields to the header and detail section of 
your layout.

Reference 
Number

Window Section Section Purpsose

Receiving 
Information

The fields in this section of the window are used to display 
and enter information about the entire transaction. See 
“Defining Header/Receiving Information” on page 30 for 
information on setting up the layout of this section. 

Detail Information The fields in this section of the window are used to display 
the items in the transaction. For additional information on 
setting up the layout of this section, see “Defining Detail 
Information” on page 31. 

Landing Information The fields in this section of the window are used to enter 
and display information about the landing costs for this 
transaction. Refer to “Defining Landing Information” on 
page 31 for additional information on setting up the layout 
of this section.

Invoice Information The fields in this section of the window are used to enter 
and display information about the invoice. For additional 
information on setting up the layout of this section, see 
“Defining Invoicing Information” on page 31.

Transaction Total The fields in this section of the window reflect the various 
running totals pertaining to the current transaction. 
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Figure 10: PO Enter Purchase Orders window, Header UDF 

Creating a New Layout 
Consider the needs of your business and either leave the default layout settings or use the instructions 
in this section to create as many screen layouts as you want. 
To create a new Layout Code:

1 In the Purchase Order module, select Options > Customize Purchasing and Receiving Windows 
from the left navigation pane. The PO Set Up Purchasing/Receiving Layout window will open. 
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Figure 11: PO Set Up Purchasing/Receiving Layout window

2 In the Layout Code box, enter a new code of up to six characters.
3 In the Entry Window drop-down list, specify whether your buyers will use this layout for entering 

purchase orders or receiving transactions. 
4 Enter a description of up to 50 characters to help you identify this code. Select the Help button in the 

software for specific information on the options in this window. 

Defining Vendor Information
The Vendor tab of the PO Set Up Purchasing/Receiving Layout window is only visible if you selected 
Purchasing from the Entry Window drop-down list. Use this tab to define what vendor information is 
displayed or can be edited while you enter purchase orders. By allowing only certain buyers the ability 
to see or edit selected vendor information, you can maintain more control over your company 
information.

Defining Header/Receiving Information
Header fields are used for information that you expect to remain unchanged throughout a single 
transaction, such as the buyer name, department, or terms. These fields appear in the Header 
Information section of the purchasing window and the Receiving Information section of the receiving 
window. Information entered in the header section applies to all detail lines entered on the transaction. 
By using the Text for heading and Column width fields, you can enter a different heading for a field in 
the entry and receiving windows and adjust the column widths to what works best for your business.
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Defining Detail Information
Detail fields are used for information that can vary within each transaction, such as the item’s stock 
number, quantity, expected date, and unit cost. In the Field Display Information section of this tab, you 
can change the heading text for any field, apply a column width that best suits your needs, and decide 
whether or not a buyer will be able to input information into a specific field. 

Defining Landing Information
Landing fields are used for information regarding landing costs, such as freight, tax, and discounts. This 
tab is only visible if you selected Receiving from the Entry Window drop-down list. If you want this 
section to be minimized by default, you can select the Minimize Estimated Landing Information 
section by default check box. You can maximize this section in the Receiving window to view the fields. 

Defining Invoicing Information
Invoicing fields are used for invoice information, such as the due date, purchase discount, and discount 
date. This tab is only visible if you selected Receiving from the Entry Window drop-down list. On this 
tab you can choose which invoicing fields you want to appear in the receiving window, if you want to 
allow input into those fields, and whether the cursor will stop in the field when tabbing through the 
window. 

Modifying an Existing Layout
At some point you might need to modify one or more settings in an existing layout. Remember that these 
settings will change for all of the buyers that have this layout attached to their Buyer Code. The changes 
you make will not take affect until the buyer closes and reopens the entry window. 
To modify an existing layout:

1 In the Purchase Order module, select Options > Customize Purchasing and Receiving Windows 
from the left navigation pane. The PO Set Up Purchasing/Receiving Layout window will open.
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Figure 12: PO Set Up Purchasing/Receiving Layout window

2 Use the Lookup or enter the Layout Code you want to modify. 
3 Select the Edit button, make any necessary changes, and save the layout. If you want to delete this 

layout, select the Edit button and then select the Del button. 

Purchase Order Codes
In Purchase Order, you can use codes to identify buyers, departments, and shipping methods. You can 
also use codes to streamline certain tasks, such as adding comments to orders and tracking custom 
information for your business. You are required to set up some codes, including Buyers Codes, 
Department Codes, and Layout Codes. For your convenience, we included at least one predefined code 
for each type that is required, but you can modify these codes or create new ones to meet your needs. 
This section includes information on each code and how you can benefit from using it. To set up codes, 
select Options on the left navigation pane and then select the desired code. 
Depending on how you set up integration between installed modules, some features and functions of 
these codes might be different. For more information on integrating modules, see “Purchase Order 
Relationship with Other Modules” on page 23.
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Establishing Purchasing Departments (Department 
Codes)
Department Codes allow you to track purchasing and receiving related costs for different departments 
within your business. They also define to which general ledger accounts purchasing expenses are 
posted. When you set up Buyer Codes (see “Setting Up Your Users (Buyer Codes)” on page 33) you 
can attach a Department Code to each Buyer Code to ensure that each buyer’s orders will be posted 
to the correct general ledger accounts.

Figure 13: PO Department Codes window

Setting Up Your Users (Buyer Codes)
By setting up Buyer Codes for your users, you can control how much access they have to saved 
purchase orders/requisitions and vendor or stock item information. You can determine whether a buyer 
can edit, view, and generate only their own orders or other buyers’ orders as well. You can even control 
what they can enter in a purchase order/requisition, whether they can print it, and if they can post 
information when receiving. 
On the Purchasing and Receiving tabs of the PO Buyer Codes window, you can attach a specific 
screen layout that you previously set up to the Buyer Code. This allows you to further control what each 
buyer has access to and what he or she can view or edit. 
Keep in mind that you must have a Department Code and Layout Code set up that you can attach to 
the Buyer Code before you can save it. You can use the Denali default Codes or you can attach your 
own Layout and Department Codes. See “Establishing Purchasing Departments (Department Codes)” 
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on page 33 for information on setting up Department Codes. Any of these codes can be modified after 
you attach them, but remember that the changes you make will affect all of the Buyer Codes to which 
the modified codes are attached. These buyer settings override any user rights you set up in Controller.

Figure 14: PO Buyer Codes window

 windowSelect the Help button in the software window for detailed information about the options in this 
window. 

Setting Up Frequently-Used Comments (Comment 
Codes)
There are several different types of comments you might need to enter on your purchase orders. Often 
the same comments are repeatedly entered into orders. For these types of comments you can set up a 
Comment Code, which can then be applied to a purchase order by the buyer. This ensures that the 
comments are consistent and accurate on the purchase orders to which they are applied. This can also 
decrease entry time by allowing the buyer to choose a code, instead of repeatedly typing out the 
message.



35Setting Up the Purchase Order Module
Purchase Order Codes

Figure 15: PO Comment Codes window 

If you have comments that either require long descriptions or that sometimes appear together on 
purchase orders, you can create grouped Comment Codes to further decrease entry time. 
Grouped codes have the first five characters alike and the sixth character different. The example in this 
section uses the following grouping method for Comment Codes:

SHPNG1
SHPNG2
SHPNG3
SHPNG4

Each Comment Code identifies a different comment line (line of text). The sixth character can be a letter 
or a number. When selecting a Comment Code using the Lookup during purchase order entry, the 
system adds all comments for all codes that have the same first five characters to the transaction. This 
feature is useful for both long descriptions and for different comments that sometimes appear together 
on transactions. 

If you have a one-time comment to add, you can do so directly in the entering or receiving detail grid 
(see “Entering Comments” on page 48).

Example: How could I group comments for shipping 
instructions?
Suppose you have the following Comment Codes set up:
SHPNG1 Please ship products using XYZ Shipping Company.
SHPNG2 Contact us if a different shipping company must be used.
SHPNG3 Please notify us if additional charges apply.
SHPNG4 Please notify us if there will be a delay in shipping.

If you enter the Comment Code SHPNG in the entry window, all four comment lines will 
appear, one after the other.
If you enter the Comment Code SHPNG3, only the third and fourth comment lines will 
appear.

By setting up groups of Comment Codes in this manner, you can keep similar comments 
together and help streamline purchase order entry.
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Preparing for Recurring Orders (Frequency Codes)
Frequency Codes allow you to group together recurring purchase orders that you might want to 
generate together. For information on recurring purchase orders, see “Creating a Recurring Purchase 
Order” on page 79. Frequency Codes are user-defined, six character codes that represent the different 
groupings you use. When you generate recurring orders, you can select them based on their Frequency 
Code. For example, you might create a Frequency Code of MONTH for purchase orders that should be 
generated on a monthly basis, or you might create MNTH15 to group together all transactions that 
should be generated on the fifteenth day of each month.

Figure 16: PO Frequency Codes window

Setting Up Your Shipping Options (Ship Via Codes)
You can create a Ship Via Code for each method by which you ship the items in your orders. This helps 
streamline the entry process by allowing buyers to choose a shipping option from those that are already 
set up in the system. If you have the Sales module installed and Ship Via Codes set up, those codes 
are also available for use in Purchase Order. 

Figure 17: PO Ship Via Codes window
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Setting Up User-Defined Codes
If you set up any of your User-Defined Fields (UDFs) as a Text Field Type and selected the Lookup/
Code check box in the PO Add or Edit User-Defined Fields window (see “Tracking User-Defined 
Order Information” on page 25), you can select the UDF from Options > Codes on the menu bar. After 
you select the code, you can define as many instances of it as you need for your business. You can then 
attach the specified codes to purchase orders if you set up the UDF to show in your layout. For example, 
if you have a UDF of Approved By, you can create codes that identify the different people in your 
company that approve purchase orders.

Figure 18: PO Approved By Codes window.

Printing a Code Report in Purchase Order
Once you create several codes, you might want to print out a complete list of all the codes for record 
keeping or for reference. A code report can be printed for any or all of the codes. 
To print a code report in Purchase Order:

1 Select Options from the navigation pane and select the code for which you want to print the report. 
The code entry window appears for the selected code.

2 Select Print.
3 In the Print Codes window, select the Print Current Code Only check box if you only want to print a 

report for a single code.
4 Select OK to print the desired code(s). 
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Figure 19: PO Buyer Codes Report

Changing or Deleting Codes
Once a code is created in Purchase Order, you can change its description and some of the other 
information at any time. However, once a code is in use, it is important to know how a change will affect 
the rest of the software. For example, if you change a Department Code or a Layout Code, the change 
is going to affect all the buyers to which those codes are attached. Changes you make to codes will not 
affect previously posted transactions.

To change or delete a code:
1 Select Options > <Code you want to modify> from the left navigation pane.
2 Type the code or use the Lookup to select the code you wish to change or delete.
3 Click the Edit button. This button then changes to read Del. 
4 If you are editing the code, make your changes and select Save.

- or -
If you are deleting this code, select the Del button. 
If you try to delete a code that should not be deleted because it’s attached to records or transactions, 
you will receive an error message. You can then print out a report indicating what the code is attached 
to.  

NOTE:  If you delete a code, please be aware that you might need to add a new code to 
any transactions or records it was attached to before you can successfully post.

Code type To delete it 

Buyer You must detach Buyer Codes from unposted 
transactions before you can delete the Codes.
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Managing Alert Email Addresses
If you want to send email alerts to let certain employees know that a batch is ready for processing, add 
the email addresses in the Manage Internal Control Alerts window. After you enter an email address, 
it will appear in the list box. The alert will be sent to all the email addresses with the check box selected 
in this window. 
To access the Manage Internal Control Alerts window, select Options > Manage Internal Control 
Alerts from the left navigation pane. From the submenu, click either Receiving or Purchasing. 

Figure 20: Manage Internal Control Alerts - Receiving

Enter an email address in the Email Address field and click Add or press Enter on your keyboard. You 
can only add one address at a time. Click the OK button when you’re done adding email addresses. 
To send out the alerts, open the Send Internal Control Alerts window on the Receiving Tasks or 
Purchasing Tasks menu. You must also set up the outgoing email account in Controller before you can 
use this feature.

Comment You can delete Comment Codes to prevent them 
from being used in the future. However, all 
Comment Codes that were already included with 
transactions will still be visible. 

Department You must detach Department Codes from all Buyer 
Codes and unposted transactions before you can 
delete the Codes.

Frequency You must detach Frequency Codes from all records 
before you can delete the Codes.

Ship Via You must detach Ship Via Codes from any 
unposted transactions before you delete the 
Codes.

Layout You must detach Layout Codes from all Buyer 
Codes before you can delete the Layout Codes.

Code type  (Continued) To delete it  (Continued)
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Troubleshooting: Setting Up the Purchase Order 
Module

At times, problems or errors can occur that are simple to fix without contacting Customer Support. Here, 
we indicate some common problems and ways to correct them. If you do not find what you are looking 
for in this section, refer to the help options under the “Denali Help” section of this guide and/or check 
the Documentation section of our Customer Service Center at https://service.cougarmtn.com/
documentation/ before you contact Customer Support. If you would like to offer suggestions for 
additions to our Troubleshooting sections, please email us at documentation@cougarmtn.com. 
 

To Fix This: Try This:

I have preprinted purchase orders that I want 
to continue to use, but they do not match 
Denali’s entry window.

You can modify many of the fields in the 
purchasing and receiving windows. This 
includes disabling fields for editing, changing 
the field label, or removing the field completely 
from the window.

To do this, either select Options > Customize 
Purchasing and Receiving Windows from 
the navigation pane or select the Options slide-
out menu > Set Up Purchasing/Receiving 
Layout button from within the entry window.

I am unable to generate recurring purchase 
orders that I know my co-worker created.

You might not have rights to generate other 
buyers’ orders. You can verify this by selecting 
Options > Set Up Buyer Security from the 
navigation pane. On the General Options tab, 
verify that the Generate only my recurring 
purchase orders check box is unchecked. If it 
isn’t, check with your manager or if authorized, 
uncheck it and continue with your task.
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There are many different tasks to complete when you enter purchase orders in the PO 
Enter Purchase Orders window. The information in this chapter will help you become 

acquainted with the entry window and the tasks you perform in it. You can set up this 

window in various ways for different buyers in order to maintain security and efficiency 

(see “Using the User-Defined Fields After Setup” on page 28).

Common Entry Tasks
There are several basic tasks you need to complete to enter a purchase order in the PO Enter Purchase 
Orders window. For example, you need to ensure the active batch is set to Single (or set up/select a 
batch if the Enable encumbering check box is selected in Module Preferences), enter the item(s) you 
are ordering, apply any freight charges or discounts, and possibly print the purchase order. The 
information in this section will help you complete these and other basic tasks.

Figure 21: PO Enter Purchase Orders window

To become more familiar with the different elements in the window, see “Overview of the Entry Window” 
on page 26. If you need information on setting up batches, see “Working with Batches in Purchase 
Order” on page 21. For information on setting up the layout for the entry window, see “Using the User-
Defined Fields After Setup” on page 28.
Select the Help button in the software for detailed information about the options in this window. 

Selecting a Buyer
Before you can begin to enter purchase orders, you need to make sure the active batch is set to Open 
and log in with your Buyer Code (see “Setting Up Your Users (Buyer Codes)” on page 33 for information 
on setting up Buyer Codes). If your Buyer Code exactly matches your Denali User ID and the If User 
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ID matches a Buyer Code default to that Buyer Code check box is selected on the Defaults tab of 
the PO Module Preferences window, the PO Buyer Login window appears defaulted to your Buyer 
Code. You just need to enter your password to access the entry window. 

Figure 22: PO Buyer Login window

The entry window you see is based on the Layout Code attached to the buyer.
If different buyers enter purchase orders on the same workstation, you can log on and off between 
orders without having to exit and enter the module again. Select the Log Off Buyer button in the entry 
window and each buyer can enter his/her buyer login information.

Figure 23: PO Enter Purchase Orders window, Log Off Buyer button

Entering a Purchase Order Number
Whether the purchase order number is auto-generated or you enter the number each time you create 
an order depends on a few settings in Module Preferences. If the Pre-issue purchase order numbers 
check box on the General tab of the PO Module Preferences window is checked, then you can use 
the Lookup to choose a pre-issued number (see “Pre-Issuing Purchase Order Numbers” on page 76). 
The numbers available in the Lookup are based on those assigned to your Buyer Code (see “Setting 
Up Your Users (Buyer Codes)” on page 33). If you are encumbering, the Lookup will show open orders 
in the active batch. 
If the Online purchase order numbering check box on the General tab of the PO Module 
Preferences window is selected, then the purchase order number is generated by the computer when 
you save the order. 
If neither the pre-issue purchase order numbers or the online numbering system options are selected 
in Module Preferences, then the purchase order number is system-generated when you open the entry 
window. This number is based on what appears in the Last Purchase Order Number field on the 
Default tab of the PO Module Preferences window. If your rights allow, you can edit this number at any 
time before you save the purchase order.
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Selecting a Vendor
If Purchase Order is integrated to Accounts Payable, and you are not entering a paid out purchase order 
(see “Entering a Paid Out Purchase Order” on page 51 for information on paid outs), you must select a 
vendor before you can save the order. You will have access to all of your vendor and past ordering 
information. By using the available history, financial, and reporting information, you can ensure that you 
are ordering from the best vendor for the item. If Purchase Order is not integrated to Accounts Payable, 
the Vendor field reads PAID OUT.
When you select a vendor, the vendor’s address entered in Accounts Payable populates the address 
fields by default. If you want to change the address for this order, uncheck the Use AP Vendor Address 
check box and type the address in the Vendor Address fields. If this vendor’s address is later changed 
in Accounts Payable, the address on the purchase order remains as it was entered when the order was 
saved. If you want to update the address on the purchase order to match the new address, select the 
Use AP Vendor Address check box. 

Figure 24: PO Enter Purchase Orders window, Use AP Vendor Address check box

If you have the rights to do so, you can add a vendor that is not already in the system. You can do this 
by double-clicking in the Vendor field and then selecting the Add button from the Lookup window that 
appears. 

Handling Stock Items in a Purchase Order
You can include stock items in the purchase order by either typing in the item number or, if Purchase 
Order is integrated to Inventory, using the Lookup. If you have rights to do so, you can create inventory 
items on the fly for new items and you can even view previous orders and choose to place that same 
order. Review the information in this section to learn how to perform these and other tasks related to 
entering stock items in a purchase order. 

Creating Inventory Items Not Showing in the Lookup
If you need to order a stock item that isn’t already in the system and you have rights to do so, you can 
add it on the fly without closing the entry window. 
To add a stock item that isn’t already in Inventory:

1 In the Stock Item field of the PO Enter Purchase Orders window, type the new stock number or 
double-click to open the Lookup. 

2 If you opened the Lookup, select Add to open the IN Stock window.
- or -
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If you typed the new stock item number, when the No Information Detected in System window 
appears, select Add a New Inventory Stock Item to add the item to Inventory. 

Figure 25: PO No Information Detected in System window 

3 Once you finish adding the stock item to the system, it is automatically included in the current 
purchase order.

4 Continue entering information to complete the order. 

Placing Orders from Purchase History
If you previously purchased items from the selected vendor, you can view your purchase history and 
select items from it to add to your current order. For example, if you are ordering from JOY’S UNIQUE 
BOOK SUPPLIES, you can view your purchase history by selecting either the History button in the 
entry window or the Purchase History button located on the History slide-out menu. In the Purchase 
History window that appears, you can select any item(s) you want to add to the current order. 
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Figure 26: PO Purchase History window

Choosing a Stock Item Variant
If you set up stock items with variants you will need to choose which variant you want to purchase. When 
you enter the stock item in the Stock Number field, the Description column will have a Lookup to select 
the variant. If your variants were set up with a SKU/UPC attached, the correct variant will autofill.

Figure 27: PO Entry window, choose a variant from Description field
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Changing an Item on a Purchase Order
Once you add a detail line to a purchase order in the PO Enter Purchase Orders window, you can edit 
it as necessary. To change an item, click the field in the detail line you want to change and type the stock 
number or use the Lookup to enter the correct item. If the order has been saved, the information you 
can change depends on the rights established for your Buyer Code (see “Setting Up Your Users (Buyer 
Codes)” on page 33). 

Deleting an Item on a Purchase Order
If you realize you entered the wrong items in a purchase order, there are two ways to correct it. If you 
have multiple incorrect items, you could clear the entire order and start over (see “Clearing or Deleting 
a Purchase Order” on page 49). If you only have one item to delete or you don’t want to clear the entire 
order, right-click on the appropriate detail line and select Delete Row from the menu that appears. Or, 
highlight the detail line and press CTRL+D on your keyboard. On a previously saved order, the 
information you can delete depends on the rights established for your Buyer Code (see “Setting Up Your 
Users (Buyer Codes)” on page 33).

Entering a Direct Expense
Some of your purchase orders might include a direct expense in addition to, or instead of, an inventory 
item. A direct expense, such as marketing brochures, is expensed directly to the general ledger account 
that you specify. These expenses are entered in the Detail Information section of the PO Enter 
Purchase Orders window. Right-click in the detail line and choose Direct Expense from the menu that 
appears. You can then choose the correct general ledger account and finish filling in the detail 
information.

Figure 28: PO Enter Purchase Orders window, direct expense

Adding Other Items to Purchase Orders
Aside from general ordering information and adding stock items or direct expenses to the purchase 
order, there are other items or expenses that you might want to add. For example, you might have 
freight charges to add or a discount from the vendor to include. Refer to the content in this section for 
information on adding these additional items to an order. 
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Entering Freight Charges
If the Freight Type field in the Header of the PO Enter Purchase Orders window is set to Collect or 
Added, you can enter freight charges in the Freight Amt field for this purchase order. You can set the 
default freight type for this field on the Defaults tab of the PO Module Preferences window. If there is 
a specific location where you assume responsibility for the freight and freight charges, then you can 
enter this location into the F.O.B field. 

Figure 29: PO Enter Purchase Orders window, freight charges

The freight amount that you enter in the Header Information section will appear in the Totals section 
of the window. 
You can select which items to distribute freight costs to in the Detail section of the window if you selected 
Inventory or All Lines as the Items to Land in Module Preferences.

Entering Discounts
Certain vendors might offer discounts that you can include in the purchase order. In the Header section 
of the entry window, you can select the type of discount (dollar or percent) and enter the discount 
amount. In the Detail section of the window, you can select which line items receive the discount. 

Figure 30: PO Enter Purchase Orders window, discounts

The total discount amount will appear in the Totals section of the window.

Entering Comments
There are two basic types of comments you might include in a purchase order—one-time comments 
and comments that you will reuse. Most likely you will type one-time comments in as you enter the 
purchase order, while recurring comments are most often set up in the PO Comment Codes window.
To add a comment that is specific to one purchase order:

1 In the Stock Number field of the Detail grid in the PO Enter Purchase Orders window, right-click and 
select Insert Comment from the drop-down menu. The Enter Purchase Order Comments window 
appears. 

2 In the Comment window, enter the comment that you want to include in the purchase order.
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You can type as much information as necessary. If the Auto format comments check box is checked 
on the General tab of Module Preferences, the system will format the comment when it is placed into 
the detail section of the purchase order. If the Auto format comments check box is unchecked, the 
comment will be formatted exactly as you typed it, including line breaks and blank lines. Each line 
cannot be longer than 50 characters; if it is you will receive an error message.

Figure 31: PO Enter Purchase Orders window, comments

3 When you are finished typing the comment, select OK to include it in the purchase order. The new 
comment line(s) will be inserted above the detail line you were on when you right-clicked the mouse 
and the column heading will change to read Comment.

4 If you need to edit the comment for any reason, right-click on any detail line and select Edit Comment 
from the menu. 
To include a Comment Code in the purchase order:

1 In the detail line that you want the comment to appear, right-click and select Insert Comment Code 
from the menu that appears. The PO Comment Codes Lookup window will open.

2 In the Lookup window, select the Comment Code that you want to include. If there are multiple 
Comment Codes with the same beginning characters, all the Comment Codes subsequent to the one 
you select will be included in the order. See “Setting Up Frequently-Used Comments (Comment 
Codes)” on page 34 for more information on how this feature works. 

3 Click Select from the Lookup to add the comment to the order. 

Clearing or Deleting a Purchase Order
You might need to delete a purchase order that has already been saved or clear an entire order that you 
are currently entering. Whatever the reason, you can delete an order that has already been saved or 
clear a purchase order that has not yet been saved. 
There are two ways that you can clear an unsaved purchase order. The first option is to select the New 
Purchase Order icon in the entry window, and then select No in the message that appears. The other 
option is to select Purchase Order > New Purchase Order from the entry window menu bar which 
opens another instance of the entry window. You can then enter the correct purchase order in the new 
window and close the first one without saving.
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Figure 32: PO Enter Purchase Orders window, create new purchase order

 To delete a saved, but not yet received purchase order, you first must recall the order. You can do this 
by selecting Purchase Order > Retrieve Purchase Order from the menu bar and select the order from 
the Lookup window, or select the Find arrows next to the PO# field until the correct purchase order 
appears. If you are encumbering, the Lookup will show open orders in the active batch. Then, you can 
either select Purchase Order > Delete Purchase Order from the menu bar, select the Delete Purchase 
Order icon in the entry window, or select the Delete PO button from the Options slide-out menu. 
Remember that to accomplish this task you must have rights to delete purchase orders.
If you want to edit a saved purchase order, see “Editing a Purchase Order” on page 54.

Figure 33: PO Enter Purchase Orders window, delete saved purchase order

Printing a Purchase Order
You can print a purchase order right after you enter and save it, or you can print purchase orders that 
were previously saved.
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To print purchase orders as you enter them: 
1 Enter the purchase order information in the PO Enter Purchase Orders window.
2 Either select the Print PO button or right-click in the detail grid and select Save and Print Purchase 

Order from the menu.
3 In the PO Print Purchase Orders/Requisitions window that appears, the current purchase order will 

be selected and ready to print. For detailed information about the options in this window, select the 
Help button. 

4 Select OK to print the purchase order.
To print purchase orders that were previously saved, see “Printing Purchase Orders and Requisitions” 
on page 99.
If you defined a custom report for this window in Controller, you can select the Use a custom report 
check box and then choose the custom report you want to run from the drop-down. See the Controller 
guide for more information on setting up custom reports.
You can add fields to preprinted purchase orders through Crystal Reports®. See the Crystal Reports 
documentation for information on how to do this. 

Periodic Entry Tasks
Besides the most common entry tasks, there are other tasks a buyer might want to perform when 
entering purchase orders. These tasks include editing a previously saved purchase order, entering a 
drop ship address, and generating purchase orders from Inventory. These sections give detailed 
information on performing these entry tasks.

Entering a Paid Out Purchase Order
There might be occasions when you want to enter a purchase order for which there is no vendor. 
Perhaps you are placing an order that you know is going to be a one-time order or you are ordering from 
a vendor that you know you will not do business with again. In these instances you can enter a paid out 
purchase order. If you have Purchase Order integrated to Accounts Payable, when this order is received 
and posted, an invoice for freight charges will post to Accounts Payable.

Figure 34: PO Enter Purchase Orders window, paid out transaction

To enter a paid out purchase order, select the Paid Out check box in the PO Enter Purchase Orders 
window. When you do this, the Vendor field will read PAID OUT and you can continue entering the 
remaining purchase order information (see “Common Entry Tasks” on page 42). When you open a 
Lookup, the Vendor Number will be blank for all Paid Out orders. 
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Entering a Drop Ship Address
If you want to ship an order straight to a customer or to an address other than the one set up in the CMS 
Organization Information window, you can select to drop ship the order to an address of your choice. 
To drop ship a purchase order:

1 Select the Drop Ship check box in the Vendor / Shipping Information section of the PO Enter 
Purchase Orders window. 

Figure 35: PO Enter Purchase Orders window, drop ship transaction

2 In the Drop Ship Customer field that appears, enter a customer number or select one from the 
Lookup.

3 If you do not want to save this address, enter the address that you want the order to ship to in the 
address fields.
- or -
Select the Ship To button to open the PO Multiple Shipping Addresses window from which you can 
choose the correct shipping address from those available for the selected customer. You can also add 
a new address in the window that will be saved for future use. 

4 Complete the purchase order as you normally would (see “Common Entry Tasks” on page 42). 

Viewing Vendor Information
If you have Purchase Order integrated to Accounts Payable, you can view three different types of 
vendor information while you enter purchase orders. You can view financial information about a vendor, 
transaction history, and purchase history. This information helps ensure that you are ordering item(s) 
from the vendor with the best price and delivery time. 
Once you select a vendor for your purchase order you can select the Financial button in the entry 
window to view financial information about the vendor. You can view information such as the vendor’s 
credit limit, payment discount percentage, and total due.
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Figure 36: PO Enter Purchase Orders window, view financial information

This type of information helps you see your current standing with the vendor. You can also determine 
the discount amount, if any, you will receive with this order if you pay by a certain date. When you are 
finished reviewing this information, click the Continue button to close the Financial window.
After you select a vendor, you can view the vendor’s transaction history by opening the History slide-
out menu and selecting the Vendor Transaction History button. The PO Vendor Transaction History 
window appears which contains the same information shown on the History tab in the AP Vendors 
window. This information includes the reference number, due date, and total amount of each transaction 
processed for the selected vendor only. This feature allows you to view a running transaction history 
without having to leave the entry window. 

Figure 37: PO Vendor Transaction History window

After you select a vendor, you can also view your purchase history with them directly from the entry 
window. You can add items to the current order from your purchasing history to speed the entry process. 
To accomplish this, you can either select the History button in the entry window or the Purchase 
History button from the History slide-out menu. See “Placing Orders from Purchase History” on 
page 45 for more information on adding items to the purchase order from this window.



54Entering Purchase Orders
Periodic Entry Tasks

Figure 38: PO Purchase History window

Editing a Purchase Order
There might be times when you need to edit a previously saved purchase order. Perhaps you need to 
change an item, add an item, or adjust an item’s quantity. Remember that you can only edit a purchase 
order that is open (it has not been marked complete) and if no unposted receiving transaction exists for 
it. You must also have rights to edit. For more information on editing rights, see “Setting Up Your Users 
(Buyer Codes)” on page 33. 
There are three ways that you can recall the purchase order that you want to edit. 

• Open the PO Enter Purchase Orders window, double-click in the PO# field, and then select the 
purchase order from the Lookup. 

• Select Purchasing Tasks > Edit an Open Purchase Order from the navigation pane and then 
from the Lookup that appears, choose the purchase order you want to edit. 

• Select Purchase Order > Retrieve Purchase Order from the Enter Purchase Order menu bar 
and select the correct order form the Lookup. 

Once the order opens in the entry window, make the necessary changes and save the purchase order. 
If you want to clear or delete the purchase order, see “Clearing or Deleting a Purchase Order” on 
page 49.

Auto-generating Orders Based on Inventory
To save time, if Purchase Order is integrated to Inventory, you can create purchase orders that generate 
based on your stock counts. You can set up the system to automatically include items that are below a 
certain stock level, decide how many days you want to order for, and choose from which vendor to order. 
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This computer-assisted process helps ensure that items are ordered when necessary to help keep your 
business running smoothly. For information on setting up your stock items in Inventory to use with this 
feature, see the Inventory guide.
Stock items with variants cannot be generated from Inventory. You must order these items from the 
Entry window.
To generate purchase orders from Inventory:

1 Select Purchasing Tasks > Generate Purchase Orders based on Inventory Levels from the left 
navigation pane to open the PO Generate from Inventory window. 

Figure 39: PO Generate From Inventory window

2 Choose from the options in the window to include all of the necessary items. For detailed information 
about the options in this window, select the Help button. 

3 Select OK to review the items that are included in the purchase order in the PO Generate From 
Inventory - Review and Select Items window. 

4 Make any necessary changes and select Generate to create purchase orders for the items you 
selected. 
You can then view and edit the orders in the entry window. 

Sending Email Alerts
You can send emails to let select employees know that a batch is ready for processing. 
To send an email alert:

1 Select Purchasing Tasks > Send Internal Control Alerts - Purchasing from the left navigation 
pane. The PO Select Batch window will open.

2 From the drop-down, select the batch you want to send an alert for. The Send Internal Control Alerts 
window will open.
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Figure 40: Send Internal Control Alerts window 

The alert email will be sent to all the addresses listed in the Recipients list box. You can only edit these 
addresses in the Manage Internal Control Alerts window (see “Managing Alert Email Addresses” on 
page 39 for information about adding email addresses.
The subject of the email includes the batch that is ready for processing.

3 Add the body text of your email in the Message text box. 
4 Click Send to send the email. It will be sent from the email account set up in Controller. 
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Troubleshooting: Entering Purchase Orders
At times, problems or errors can occur that are simple to fix without contacting Customer Support. Here, 
we indicate some common problems and ways to correct them. If you do not find what you are looking 
for in this section, refer to the help options under the “Denali Help” section of this guide and/or check 
the Documentation section of our Customer Service Center at https://service.cougarmtn.com/
documentation/ before you contact Customer Support. If you would like to offer suggestions for 
additions to our Troubleshooting sections, please email us at documentation@cougarmtn.com. 
 

To Fix This: Try This:

When attempting to edit a saved, but not yet 
received purchase order, I am unable to find it 
in the Lookup.

Check to make sure that you have the active 
batch set to Single and not Recurring. Do this 
by selecting Purchasing Tasks > Set the 
Active Batch To Single from the navigation 
pane.

If you are still unable to locate the purchase 
order, you might consider running an edit report 
to make sure the order wasn’t accidentally 
deleted from the system.

I want to add freight charges to the purchase 
order, but the fields don’t appear in the entry 
window. 

Make sure that the Items to Land drop-down in 
Module Preferences has either Inventory or All 
Lines selected. 

Also, make sure that your screen layout is set 
up to show these fields. See “Using the User-
Defined Fields After Setup” on page 28 for 
information on setting up layouts. 
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If your organization’s processes include using requisitions in addition to purchase 

orders, the information in this chapter will explain how to enter and approve a 

requisition. Like purchase orders, the entry screen layout you see will be the one that 

is attached to the Buyer who is logged in. 

Selecting a Buyer
Before you can begin to enter requisitions, you need to make sure the active batch is set to Open and 
log in with your Buyer Code (see “Setting Up Your Users (Buyer Codes)” on page 33 for information on 
setting up Buyer Codes). If your Buyer Code exactly matches your Denali User ID and the If User ID 
matches a Buyer Code default to that Buyer Code check box is selected on the Defaults tab of the 
PO Module Preferences window, the PO Buyer Login window appears defaulted to your Buyer Code. 
You just need to enter your password to access the entry window. 
Any buyer can enter requisitions, but only buyers with rights can view requisitions entered by other 
buyers, edit requisitions, or approve them. 

Figure 41: PO Buyer Login window

If different buyers enter requisitions on the same workstation, you can log on and off without having to 
exit and enter the window again. Select the Log Off Buyer button at the top of the entry window and 
each buyer can enter his/her buyer login information.
The entry window you see is based on the Layout Code attached to the buyer.

Creating Requisitions
Entering information for requisitions is the same as entering purchase orders. The Approver field is the 
only additional field and it is optional. If a certain buyer needs to approve the requisition, you can enter 
their Buyer Code in the Approver field.
To enter a requisition, select Purchasing Tasks > Create a Requisition from the left navigation pane. 
The PO Enter Requisitions window opens.
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Figure 42: PO Enter Requisitions window

Enter all of the requisition information and save it. Buyers with rights can view the requisition and edit, 
approve, or deny it. 
When a requisition is approved it becomes a purchase order, but you can view it in the Enter Purchase 
Orders or Enter Requisitions windows. This allows Buyers that only have requisition rights to see the 
status of requisitions they entered.
If you use encumbrances and multi-batch mode, and you delete a batch before you post, any changes 
to the requisitions in the batch will not be saved to the open batch.

Approving Requisitions
After a requisition is saved, it can be approved or denied. Buyers can run the Requisition Report to view 
requisitions that are awaiting approval. You can also have Buyers who enter requisitions send email 
alerts to the approvers so they know requisitions are ready. To see saved requisitions, select 
Purchasing Tasks > Edit an Existing Requisition from the left navigation pane. From the Lookup, 
select the requisition you want to see. The PO Enter Requisitions window will appear with the requisition 
you selected in view. 
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Figure 43: PO Enter Requisitions window, Requisition drop-down

Only buyers with rights can approve or deny requisitions. If the requisition was saved with a Buyer Code 
in the Approver field, only that Buyer can approve the requisition. However, any Buyer with editing 
rights, can change the Buyer Code that is in the Approver field. 
If the Approver field is blank, any Buyer with rights can approve the requisition. Once a requisition is 
approved, the Approver field will auto-fill with the logged in buyer and you cannot change it. 
There are three options from the Requisition Status drop-down—Pending Approval, Approved, and 
Denied. If you deny the requisition, it can be edited and sent through the approval process again. If you 
approve the requisition, it becomes a purchase order. 

Editing Requisitions
If a requisition has been denied or needs to be edited for any reason, you must have buyer rights to 
make changes. 
To edit a requisition, select Purchasing Tasks > Edit an Existing Requisition from the left navigation 
pane. Then, in the Lookup that appears, select the requisition you want to edit. The Enter Requisitions 
window will open with that requisition in view. 
You can also edit a requisition from the Enter Requisitions window. To do this, click the magnifying glass 
next to the PO # field to open the Lookup. Find the existing requisition you want to edit and select it. 
If a requisition has already been approved, you can make changes to it through the Requisition or 
Purchase Order windows. For all requisitions, even those that have been approved, a Requisition label 
will appear at the top of the window.

Printing Requisitions
You can print requisitions as you enter them, or you can print requisitions that were previously saved.
To print requisitions as you enter them: 

1 Enter the requisition information in the PO Enter Requisitions window.
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2 Either select the Print PO button or right-click in the detail grid and select Save and Print Purchase 
Order from the menu.

3 In the PO Print Purchase Orders/Requisitions window that appears, the current requisition will be 
selected and ready to print. For detailed information about the options in this window, select the Help 
button. 

4 Select OK to print the requisition.
To print requisitions that were previously saved, see “Printing Purchase Orders and Requisitions” on 
page 99.
If you defined a custom report for this window in Controller, you can select the Use a custom report 
check box and then choose the custom report you want to run from the drop-down. See the Controller 
guide for more information on setting up custom reports.
You can add fields to the preprinted format through Crystal Reports®. See the Crystal Reports 
documentation for information on how to do this. 

Sending Requisition Email Alerts
You can send emails to let select buyers know that requisitions are ready for approval. 
To send an email alert:

1 Select Purchasing Tasks > Send Internal Control Alerts - Requisitions from the left navigation 
pane. The PO Buyer Login window will open.

2 From the drop-down, select your Buyer name and enter your password. The Send Internal Control 
Alerts window will open.

Figure 44: Send Internal Control Alerts window

The alert email will be sent to all the addresses listed in the Recipients list box. You cannot edit this list. 
These are the email addresses attached to the Buyer Codes of the approvers on the requisitions of the 
buyer who is logged in.

3 Add the body text of your email in the Message text box. 
4 Click Send to send the email. It will be sent from the email account set up in Controller. 
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Troubleshooting: Entering Requisitions 
At times, problems or errors can occur that are simple to fix without contacting Customer Support. Here, 
we indicate some common problems and ways to correct them. If you do not find what you are looking 
for in this section, refer to the help options under the “Denali Help” section of this guide and/or check 
the Documentation section of our Customer Service Center at https://service.cougarmtn.com/
documentation/ before you contact Customer Support. If you would like to offer suggestions for 
additions to our Troubleshooting sections, please email us at documentation@cougarmtn.com. 
 

To Fix This: Try This:

I want to approve a requisition, but the drop-
down that allows me to isn’t in the window. 

Make sure your Buyer rights allow you to 
approve the requisition in question. The drop-
down will only appear in the window for 
requisitions you have rights to approve. See 
“Setting Up Your Users (Buyer Codes)” on 
page 33 for more information.

I need to see a list of requisitions for a certain 
Buyer. 

You can run the Requisition report and filter it 
to view only the Buyer Code you need. See 
“Requisition Report” on page 95 for more 
information.



5
Chapter

Receiving Purchase Orders
Receiving a Purchase Order

Sending Email Alerts

Clearing Receiving Transactions

Printing Inventory Stock Labels

Troubleshooting: Receiving Purchase Orders



65Receiving Purchase Orders
Receiving a Purchase Order

You have many different options when you receive purchase orders, including whether 

you want to receive the entire order or just part of it, if you want to receive and invoice 

the transaction, and if you want to print labels for the order. The information in this 

chapter explains how to complete tasks in the PO Receive Items window.

Receiving a Purchase Order 
When you receive a purchase order, there are many different types of tasks you can perform. For 
example, you can receive part of an order or the entire order, choose how to track the landing costs, 
and add items to the existing order. All of this is accomplished within the PO Receive Items window. To 
perform certain actions in the receiving window, you must have rights to do so. These rights are 
established in the Buyer Code (see “Setting Up Your Users (Buyer Codes)” on page 33 for information 
on setting up Buyer Codes). You can also set up the window layout to meet the needs of your business 
and expedite the receiving process (see “Defining Your Purchase Order Screen Layouts” on page 26 
for information on setting up the window layout). Refer to this section for information on the tasks you 
need to complete in the Receive Items window.

Receiving an Entire Purchase Order
If you receive all of the items included in your purchase order and you want to complete it, you can 
receive the items into Inventory and invoice the items into Accounts Payable at the same time. Your 
Buyer Code must have rights assigned to receive and invoice a purchase order. See “Setting Up Your 
Users (Buyer Codes)” on page 33 for information on setting up Buyer Codes.
To receive and invoice the entire purchase order:

1 If you are using multi-batch processing, you need to set up or select a batch into which you will receive 
transactions. Then, select Receiving Tasks > Receive Items into Inventory from the left navigation 
pane. The PO Receive Items window will open. 

2 In the Receive Items window, enter the purchase order number that you want to receive in the PO# 
field or select it from the Lookup. The detail information grid populates with the selected purchase 
order information.

3 Select Receive and Invoice from the Transaction Type drop-down menu. 

Figure 45: PO Receive Items window, Receive and Invoice
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4 Select the Complete check box in the Receiving Information section of the window to mark all line 
items as complete. 
- or - 
Click the Receive All button in the Detail Information section of the window. For detailed information 
about the options in this window, select the Help button in the software. Once a receiving transaction is 
marked complete and the batch is posted, the purchase order is removed from the open batch and can 
no longer be edited. 
If you are receiving serialized items, see “Receiving Serialized Items” on page 70 for more information. 
If you are receiving lot numbered items, see “Receiving Lot Numbered Items” on page 70.

5 Edit any necessary landing information in the Landing section of the window and enter the invoice 
information that you want to post to Accounts Payable in the Invoice section of the window. 

6 When you finish filling in the information, select Save to keep the transaction. You can also print 
Inventory labels for the items you received (see “Printing Inventory Stock Labels” on page 73 for 
information on printing labels) or print the Edit Report. 

Receiving Part of a Purchase Order
If you only received some of the items in your order, you might want to receive those items into the 
system to update inventory quantities, but not invoice the order because it hasn’t been completely filled. 
Or, you might want to receive and invoice certain items, but not the entire order. You can decide for each 
line item if you only want to receive the item or receive and invoice it. Keep in mind that you must have 
rights assigned to receive and/or invoice a purchase order. These rights are established in your Buyer 
Code. See “Setting Up Your Users (Buyer Codes)” on page 33 for information on setting up Buyer 
Codes.
To receive but not invoice items in a purchase order: 

1 If you are using multi-batch processing, you need to set up or select a batch into which you will receive 
transactions. Then select Receiving Tasks > Receive Items into Inventory from the navigation 
pane. The PO Receive Items window will open. 

2 In the Receive Items window, enter the purchase order number that you want to receive in the PO# 
field or select it from the Lookup.

3 Select Receive Only from the Transaction Type drop-down menu. 

Figure 46: PO Receive Items window, Receive Only 

4 Fill in the necessary fields in the detail information grid including the quantities of the items that you 
want to receive. Select the Help button in the software for detailed information about the options in this 
window. 
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If you are receiving serialized items, see “Receiving Serialized Items” on page 70 for more information. 
If you are receiving lot numbered items, see “Receiving Lot Numbered Items” on page 70.

5 When you finish filling out the detail grid, you can print Inventory labels for those items (see “Printing 
Inventory Stock Labels” on page 73 for information on printing labels) or select Save to save the 
transaction. Once you receive all of the items included in the purchase order, you can invoice them. 
Refer to “Invoicing a Purchase Order” on page 67.
To receive and invoice only some of the items in a purchase order: 

1 In the PO Receive Items window, enter the purchase order number that you want to receive in the PO# 
field or select it from the Lookup. The detail information grid populates with the selected purchase 
order information.

2 Select Receive and Invoice from the Transaction Type drop-down menu. 

Figure 47: PO Receive Items window, Receive and Invoice

3 Fill in the necessary fields in the detail information grid, including the quantities of the items that you 
want to receive and invoice. If a line item is complete, select the Complete check box in that row. 
Select the Help button in the software for detailed information about the options in this window. 
If you are receiving serialized items, see “Receiving Serialized Items” on page 70 for more information. 
If you are receiving lot numbered items, see “Receiving Lot Numbered Items” on page 70.

4 Edit any necessary landing information in the Landing section of the window and enter the invoice 
information that you want to post to Accounts Payable in the Invoice section of the window. 

5 When you finish filling in all the necessary information, select Save to keep the transaction. You can 
also print Inventory labels for the items you received (see “Printing Inventory Stock Labels” on page 73 
for information on printing labels) or print the Edit Report. 

Invoicing a Purchase Order
If you previously received items in a purchase order, but did not invoice them, you can perform an 
invoice-only transaction. Items must be received in the system before they can be invoiced. For 
information on receiving items in a purchase order, see “Receiving Part of a Purchase Order” on 
page 66. You must have rights assigned to invoice a purchase order. These rights are established in 
your Buyer Code (see “Setting Up Your Users (Buyer Codes)” on page 33 for information on setting up 
Buyer Codes).
To invoice a purchase order:

1 If you are using multi-batch processing, you need to set up or select a batch into which you will receive 
transactions. Then select Receiving Tasks > Receive Items into Inventory from the left navigation 
pane. The PO Receive Items window will open.
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2 In the Receive Items window, enter the purchase order number that you want to invoice in the PO# 
field or select it from the Lookup.
- or -
Select Receiving Transaction > Retrieve Transaction from the receiving menu bar. From the Lookup 
that appears, select the purchase order that you want to invoice. 

3 Select Invoice Only from the Transaction Type drop-down menu. 

Figure 48: PO Receive Items window, Invoice Only

4 Select the Invoice All button in the Detail Information section of the window to invoice all items.
5 Enter the invoice information that you want to post to Accounts Payable in the Invoice Information 

section of the window. For detailed information about the options in this window, select the Help 
button. 

6 When you complete the invoice information in this window, select Save to keep the transaction. You 
can also print the Edit Report or reprint the purchase order to show all of the items received and 
invoiced. 

Tracking Landing Costs
You can apply landing costs when you receive a purchase order (see “Setting Up Purchase Order 
Landing” on page 22 for information on setting up landing defaults). You can modify the estimated 
landing information when you receive and invoice items because the actual costs aren’t applied to your 
general ledger accounts until the transaction is posted. The estimated landing costs are based on the 
information you entered in the entry window. See “Adding Items to an Existing Purchase Order” on 
page 68 for more information on entering estimated freight and discounts. 

Adding Items to an Existing Purchase Order
There might be occasions when you are receiving a purchase order and you need to add items to it. 
Perhaps extra items were sent that you are going to receive or maybe your business process is to add 
new items to the same purchase order, even after previously received items were posted. If you only 
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need to change the quantity received of an item in the order, type the amount in the Quantity Received/
Returned field in the PO Receive Items window and continue with the receiving process. If you need to 
add a completely new item to the order, the instructions in this section will assist you. 
To add an item to a purchase order:

1 In the PO# field of the Receive Items window, enter the purchase order number to which you want to 
add items or select it from the Lookup.

2 When the purchase order you selected appears, click the Add Item(s) button to open the PO Add 
Items window. 

Figure 49: PO Add Items window 

3 Enter the items and quantities that you want to add to the purchase order and fill in any additional 
information. Select the Help button in the software for detailed information about the options in this 
window. 

4 When you are finished adding items in the PO Add Items window, select OK to add the items to the 
purchase order. Items that were added from this window are highlighted in yellow in the receiving 
window.

Figure 50: PO Receive Items window, Detail Information grid with added items

5 In the PO Receive Items window, make any additional changes to the order, and select Save to keep 
the transaction.
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Receiving Serialized Items
Items must be set up in Inventory as serialized items in order to receive them as such in Purchase Order 
(see the Inventory guide). When you enter the quantity of a serialized item in the PO Receive Items 
window and move to the next field in the grid, the PO Receive Serialized Items window automatically 
appears.

Figure 51: PO Receive Serialized Items window

The window appears for each item received on the purchase order that is serialized. If you need to 
return a serialized item, see “Returning Serialized Items” on page 78. Select the Help button for 
information about the options in this window.

Receiving Lot Numbered Items
You must set up lot numbered stock items in Inventory if you want to add lot numbers as you receive 
items in Purchase Order. When you enter the quantity of a lot numbered item in the PO Receive Items 
window and move to the next detail line in the grid, the PO Receive Items - Assign Lot Numbers 
window appears. Enter each lot number and the quantity you received. You can add new lot numbers 
or use the Lookup to select existing lot numbers. You can also add an expiration date for each lot 
number, if applicable.
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Figure 52: PO Assign Lot Numbers window

The window appears for each lot numbered stock item received on the purchase order.

Sending Email Alerts
You can send emails to let select employees know that a batch is ready for processing. 
To send an email alert:

1 Select Receiving Tasks > Send Internal Control Alerts from the left navigation pane. The PO Select 
Receiving Batch window will open.

2 From the drop-down, select the batch you want to send an alert for. The Send Internal Control Alerts 
window will open.
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Figure 53: Send Internal Control Alerts window - Enter Bills

The alert email will be sent to all the addresses listed in the Recipients list box. You can only edit these 
addresses in the Manage Internal Control Alerts window (see “Managing Alert Email Addresses” on 
page 39 for information about adding email addresses.
The subject of the email includes the batch that is ready for processing.

3 Add the body text of your email in the Message text box. 
4 Click Send to send the email. It will be sent from the email account set up in Controller. 

Clearing Receiving Transactions
If you do not want to post receiving transactions, you can clear the transactions in the batch or remove 
the batch completely. Always print an Edit Report and verify that you want to delete all transactions 
shown in the report before you clear the batch. Once you clear transactions, you cannot recall them. If 
you only want to clear one transaction in the batch, see “Clearing or Deleting a Purchase Order” on 
page 49.
To clear all unposted transactions in a receiving batch:

1 Select Receiving Tasks > Clear Transactions from a Batch from the navigation pane. The PO Clear 
Receiving Transactions window will open.

Figure 54: PO Clear Receiving Transactions window
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2 If you are using multi-batch processing, select the Remove Batch check box to clear the transactions 
as well as the batch. If you want to only clear the transactions and retain the batch for future use, leave 
this check box unchecked. 

3 Select OK to clear the transactions.

Printing Inventory Stock Labels
If Purchase Order is integrated to Inventory, you can print inventory stock labels for the items you 
receive any time before you post. You can choose what you want to print on your labels, including 
whether you want to generate a bar code or just the stock item information.
To print stock labels:

1 Select Receiving Tasks > Print Labels for Received Items from the left navigation pane.
- or -
Open an existing purchase order in the PO Receive Items window and select the Print Labels button 
in the window or from the Options slide-out menu. 

Figure 55: PO Receiving Labels window

2 If you want to generate bar codes on your labels, make sure that the bar code option is turned on (the 
button will read Turn Bar Code Off).
You must have the BarTender Label Maker program installed to use this option. To order the BarTender 
program, call Cougar Mountain Sales at (800) 388-3038. You can format your labels according to the 
BarTender functionality. For more information on using this program and setting up your bar code labels, 
see the BarTender documentation. 

3 Make the appropriate selections in the window and select OK to print the labels.
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Troubleshooting: Receiving Purchase Orders
At times, problems or errors can occur that are simple to fix without contacting Customer Support. Here, 
we indicate some common problems and ways to correct them. If you do not find what you are looking 
for in this section, refer to the help options under the “Denali Help” section of this guide and/or check 
the Documentation section of our Customer Service Center at https://service.cougarmtn.com/
documentation/ before you contact Customer Support. If you would like to offer suggestions for 
additions to our Troubleshooting sections, please email us at documentation@cougarmtn.com. 
 

To Fix This: Try This:

When receiving items in a purchase order, I 
am unable to view/enter landing information.

Check first to make sure you set up the 
window layout associated with your Buyer 
Code to show landing information (see “Using 
the User-Defined Fields After Setup” on 
page 28). Then, check to see what landing 
settings are in place in the module preferences 
(see “Setting Up Purchase Order Landing” on 
page 22).

I am unable to invoice purchase orders. You might not have the rights to do so. Check 
your Buyer Code to make sure your rights are 
not set for Receive Only (see “Setting Up Your 
Users (Buyer Codes)” on page 33).

When receiving items, I would like the system 
to alert my buyers when an item’s price is 
higher than its last cost.

You can set up Purchase Order to do this by 
selecting the Show alert when cost increases 
check box in Module Preferences. See “Setting 
Up Other Purchase Order Defaults” on page 24 
for more information.
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There are many managerial tasks you can complete in Purchase Order. For example, 

you can pre-issue purchase order numbers for buyers, create and generate recurring 

purchase orders, post transactions, and purge history. Use the information in this 

chapter to learn about the different management options available.

Pre-Issuing Purchase Order Numbers
If you pre-issue purchase order numbers, you control which numbers buyers use for all purchasing 
activity. This could be used as an internal security feature within Purchase Order. To pre-issue numbers, 
you must select the Pre-issue purchase order numbering check box in Module Preferences. You will 
need to issue purchase order numbers to all of your buyers. 
Be aware that if you choose to pre-issue purchase order numbers, you cannot use online purchase 
order numbering. You also will not be able to create purchase orders from the Sales entry windows. 
After a buyer uses all of the pre-issued numbers, you must issue new numbers before that buyer can 
enter any more orders. If you use alpha characters in your purchase order numbers, we highly 
recommend that you end your numbers with a numeric character so they increment properly. 
To issue or unissue purchase order numbers:

1 Select Options > Issue Purchase Order Numbers from the left navigation pane. The PO Pre-Issue 
Purchase Orders window will open.

Figure 56: PO Pre-Issue Purchase Orders window

2 Select either Issue purchase order numbers or Unissue purchase order numbers depending on 
which task you want to accomplish. 

3 Choose the buyer and enter the range of order numbers. 
4 Click OK.

If you want to view a list of all the numbers that are currently pre-issued or provide a list to the buyers 
of their numbers, select the List radio button (see “Generating a List of Pre-issued Purchase Order 
Numbers” on page 98 for more information).



77Purchase Order Management Tasks
Entering Returns in Purchase Order

Entering Returns in Purchase Order
If you need to return an item to a vendor, you can either use an existing purchase order or a new 
purchase order. If a purchase order already exists for the vendor, you can enter the return on a separate 
detail line of that purchase order. If a purchase order does not exist for the vendor, you need to create 
a new one to handle the return.
If Purchase Order is integrated to Accounts Payable, after posting the return, the system creates a debit 
invoice memo (DB INV) for the vendor you’re returning the items to. You need to apply this debit memo 
to either the original invoice or another invoice (refer to the Accounts Payable guide).
To enter a return in an existing purchase order:

1 Click Receive Your Stock Items in the Workflow. If you are using multi-batch processing, you’ll be 
prompted to select or set up a batch to receive transactions. The Receive Items window will open. 

2 Use the Lookup to open an existing purchase order for the vendor you want to return the items to. 
3 Click the Add Item(s) button to open the PO Add Items window and enter the stock numbers that you 

want to return.
4 In the Quantity field of the PO Add Items window, enter the quantities that you want to return as a 

negative number. 
5 Select OK to return to the receiving window. The items you are returning appear in the Detail grid in 

yellow.

Figure 57: PO Receive Items window, with return

If you are returning serialized items, the PO Return Serialized Items window will appear when you 
enter the negative quantity in the Quantity Received/Returned field (see “Returning Serialized Items” 
on page 78 for information on this window). 
If you are returning lot numbered items, the PO Receive Items - Assign Lot Numbers window will 
appear when you enter the negative quantity in the Quantity Received/Returned field. 

6 Select Save. If integration is turned on between modules, posting will update the appropriate 
information and/or accounts in Inventory, Accounts Payable, and General Ledger. 
To enter a return by creating a new purchase order:

1 Click Enter Purchase Orders from the Workflow. The Enter Purchase Orders window will open. 
2 Enter the vendor that you want to return the items to in the Vendor field or select a vendor from the 

Lookup.
3 In the Detail Information section, enter the items you want to return in the Stock Number field and 

enter the quantity you want to return as a negative number in the Quantity field.
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Figure 58: PO Enter Purchase Orders window, negative quantity

4 Save the purchase order.
5 Click Receive Your Stock Items in the Workflow. If you are using multi-batch processing, you’ll be 

prompted to select or set up a batch to receive transactions. The Receive Items window will open. 
6 Open the purchase order you just created for the return and verify its accuracy. If necessary, you can 

adjust the quantity in the Quantity Received/Returned field. Because you entered a negative number 
in this field when you created the purchase order, you can only enter a negative number when you 
receive it. For detailed information about the options in this window, select the Help button in the 
software. 
If you are returning serialized items, the PO Return Serialized Items window will appear after you enter 
the negative quantity received/returned (see “Returning Serialized Items” on page 78 for information on 
this window).
If you are returning lot numbered items, the PO Receive Items - Assign Lot Numbers window will 
appear after you enter the negative quantity received/returned.

7 Receive the item(s) and save the transaction. If integration is turned on between modules, posting will 
update the appropriate information and/or accounts in Inventory, Accounts Payable, and General 
Ledger. 
Be sure to check the Edit Report before you post. 

Returning Serialized Items
If you are returning serialized items, the PO Return Serialized Items window will open when you enter 
the Received/Returned quantity for each item that is set up as a serialized item in Inventory. If you select 
the Manual Input button, you can enter the serialized numbers manually; if you select the List Select 
button, you can choose them from a list generated from Inventory. 
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Figure 59: PO Return Serialized Items window

Creating a Recurring Purchase Order
If you have purchase orders that you enter on a regular basis, you can use the recurring function to 
create a template for the order and generate it without having to enter all of the information each time. 
Once you create the template, you can generate the orders as needed (see “Generating a Recurring 
Purchase Order” on page 80).
You can also set up a recurring order at the same time you enter a regular purchase order by selecting 
the Recurring check box and entering a Frequency Code in the Entry window. 
To create a recurring purchase order:

1 Select Purchasing Tasks > Set the Active Batch to Recurring from the left navigation pane.
2 Select Purchasing Tasks > Set Up Recurring Orders from the left navigation pane. The Enter 

Purchase Orders window will open with the Recurring check box checked. 

Figure 60: PO Set Up Recurring Purchase Orders window, Frequency field
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3 Enter a Frequency Code in the Frequency field or select one from the Lookup. Frequency Codes are 
used to group orders that you will generate together. For more information on these codes, see 
“Preparing for Recurring Orders (Frequency Codes)” on page 36. 

4 Enter the information for the order as you would a regular order (see “Entering Purchase Orders” on 
page 41 for information on entering a purchase order). 

5 Select Save. The order will be saved in the recurring batch and you can generate it any time. 
When you’re done entering recurring orders, remember to change the active batch to open by selecting 
Purchasing Tasks > Set the Active Batch to Single .

Generating a Recurring Purchase Order
After you create a recurring order template (see “Creating a Recurring Purchase Order” on page 79), 
you can generate the orders any time. 
To generate recurring orders:

1 Click Generate Recurring Purchase Orders on the Workflow. The Enter Purchase Orders window 
will open.
- or -
In the PO Enter Purchase Orders window, select Generate Recurring from the Options slide-out 
menu. 

2 If you are using multi-batch processing, select the batch you want to generate the orders into (see 
“Working with Batches in Purchase Order” on page 21). If you are not using multi-batch processing, 
continue to the next step.

Figure 61: PO Generate from Recurring window 
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3 Enter the start and end ranges for the orders you want to generate. For detailed information about the 
options in this window, select the Help button in the software. 

4 Click Refresh Grid to see to see the purchase orders that will be generated. You can then choose not 
to generate certain orders. 

5 Select Generate to process your recurring orders. 
You can view the generated orders in the Enter Purchase Orders window and make any edits you need 
to. 

Reviewing Transactions
Before you post transactions, it’s important to review them using the Edit Reports. These reports allow 
you to check the accuracy of your data before you post. You can also run the Receiving Report to see 
the quantity of the items that arrived and what is still outstanding. We strongly recommend that you print 
and check these reports carefully. Errors are easier to correct if you catch them before you post. 
This section includes information about the two Purchase Order Receiving Reports, the Purchasing Edit 
Report, and how to correct errors in unposted and posted transactions. 

Printing the Receiving Edit Report
We highly recommend you run the Receiving Edit Report to review receiving transactions before you 
post. This report shows you all the items received, including their costs and quantities. You must have 
security rights assigned to run this report. 
Following are four ways you can access the Receiving Edit Report:

• Select Receiving Tasks > Preview Received Items before Posting from the navigation pane.
• Click Verify Accuracy of Received Items from the Workflow.
• Click the Print Edit Report button in the PO Receive Items window.
• Select the Print Edit Report button from the Options slide-out menu in the PO Receive Items 

window. 
Use the start and end ranges in the window to filter the report to the transactions you want to see. After 
you set the criteria in the window, you should see a report similar to the following image.
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Figure 62: PO Receiving Edit Report

Printing the Purchasing Edit Report 
We highly recommend you run the Purchasing Edit Report to review purchasing transactions before you 
post. This report shows all the items ordered, including their costs and quantities. You must have 
security rights assigned to run this report. 
Following are four ways that you can access the Purchasing Edit Report:

• Select Purchasing Tasks > Preview Purchased Items before Posting from the navigation 
pane.

• Click Verify Accuracy of Purchased Items in the Workflow.
• Click the Print Edit Report button in the PO Enter Items window.
• Select the Print Edit Report button from the Options slide-out menu in the PO Enter Items 

window. 
Use the start and end ranges in the window to filter the report to the transactions you want to see. After 
you set the criteria, you should see a report similar to the following image.
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Figure 63: PO Purchasing Edit Report

Printing the Receiving Report
You can run the Receiving Report to review purchase order transactions before you post. This report 
shows you the quantities received and the quantities remaining for all of the items in the batch(es) you 
want to post. 
Following are three ways that you can access the Receiving Report:

• Click View the Receiving Report from the Workflow.
• Select Receiving Tasks > Print the Receiving Report from the navigation pane.
• From the PO Receive Items window, click the Print Receiving Report button on the Options 

slide-out menu. 
Use the start and end ranges in the window to filter the report to the transactions you want to see. After 
you set the criteria, you should see a report similar to the following image.
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Figure 64: PO Receiving Report

Correcting Errors in Unposted Transactions
You can correct any mistakes you find on the Receiving or Purchasing Reports before you post. After 
you correct the errors, we recommend you run the reports again to verify the corrections before you post 
your transactions. If you already posted a transactions that has an error, see “Correcting Errors in 
Posted Transactions” on page 85. You must have rights to edit purchase orders; these rights are 
established in your Buyer Code. See “Setting Up Your Users (Buyer Codes)” on page 33 for information 
on assigning Buyer rights.
To correct a receiving error:

1 Click Receive Your Stock Items from the Workflow. The Receive Items window will open.
2 In the PO# field, enter the purchase order number for the order that you need to edit or select it from 

the Lookup. 
3 Make the necessary changes to the purchase order.
4 Save the transaction and run the receiving reports again (see “Printing the Receiving Report” on 

page 83 or “Printing the Receiving Edit Report” on page 81). 
To correct a purchasing error:

1 Select Purchasing Tasks > Edit an Open Purchase Order from the left navigation pane. The 
Purchase Order Lookup will open.

2 From the Lookup, select the purchase order you need to edit. 
3 Make the necessary changes to the purchase order.
4 Save the transaction and run the Purchasing Edit Report again (see “Printing the Purchasing Edit 

Report” on page 82).
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Correcting Errors in Posted Transactions
If you already posted a transaction with an error, there are two ways to correct it. If General Ledger, 
Inventory, and Accounts Payable are installed and integrated, you can manually make the adjustments 
in each module. For information on adjusting accounts in General Ledger, see the General Ledger 
guide. For information on adjusting inventory quantities, see the Inventory guide. For information on 
making adjustments in Accounts Payable, see the Accounts Payable guide. 
Your other option to correct errors that are already posted is to create a new purchase order in which 
you adjust all the errors, and then receive and post the transaction. See “Entering Purchase Orders” on 
page 41 for information on entering purchase orders, “Receiving Purchase Orders” on page 64 for 
information on receiving purchase orders, and “Posting Transactions” on page 85 for information on 
posting receiving transactions.
If you have not yet posted the transactions, you can correct the error before you post. See “Correcting 
Errors in Unposted Transactions” on page 84 for more information.

Posting Transactions
After you print and check the Receiving or Purchasing  Reports and make any corrections, you are 
ready to post your transactions. Posting will update all integrated modules (see “Purchase Order 
Relationship with Other Modules” on page 23 for integration information). 

To post receiving transactions, select Post Receiving Transactions from the Workflow. If you are using 
multi-batch mode, select the batch that you want to post.
To post entry transactions, select Post Purchasing Orders from the Workflow. This option is only 
available if you selected the Enable encumbering check box in Module Preferences (see “Setting Up 
Other Purchase Order Defaults” on page 24 for more information). If you are using multi-batch mode, 
select the batch you want to post. If there are hold transactions in the batch, the batch won’t be deleted 
after you post. 

Figure 65: PO Post Received POs window

The posting process first validates all the entered information to ensure it meets the posting criteria. The 
information is written to the file, and then the Posting/Audit reports are printed. Examine these reports 
carefully before you continue. We highly recommend that you print these reports and keep them until 
you are sure that no errors will need to be manually corrected in any modules. If an error is found, a 
Posting Error Report is generated that tells you the transaction number and the problem. 

NOTE:  We recommend you have all users exit modules that are affected by posting 
before you post. This can help prevent data corruption.
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Purging Purchase Order History
If your files have become too large, purging history can be a valuable tool. Purging removes all 
transactions that have a transaction date older than and including the purge date you specify. You are 
not required to purge transactions, but doing so might speed up the processing time when you sort or 
print reports from history. 

To purge purchase order history, select Resources and Tools > Purge History from the left navigation 
pane. 

Figure 66: PO Purge History window

Enter the date through which you want to purge the history files. Only history information that is prior to 
and including the date you enter will be purged.

CAUTION: Always back up your data files and print a History Report (see “History 
Report” on page 97) before you purge the history file. See the “Backing Up, 
Restoring, and Deleting Data” section of the Controller guide for 
information on backing up your data. 
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Troubleshooting: Purchase Order Management Tasks
At times, problems or errors can occur that are simple to fix without contacting Customer Support. Here, 
we indicate some common problems and ways to correct them. If you do not find what you are looking 
for in this section, refer to the help options under the “Denali Help” section of this guide and/or check 
the Documentation section of our Customer Service Center at https://service.cougarmtn.com/
documentation/ before you contact Customer Support. If you would like to offer suggestions for 
additions to our Troubleshooting sections, please email us at documentation@cougarmtn.com. 
 

To Fix This: Try This:

I want to pre-issue purchase orders, but I am 
unable to locate the menu item to do so.

You must first check the Pre-issue purchase 
order numbers check box on the General tab 
of the PO Module Preferences window. This 
activates the Issue Purchase Order Numbers 
option on the Options menu.

I want to pre-issue purchase orders to some 
buyers, but not all buyers.

You cannot pre-issue purchase order numbers 
to some buyers and not others. If you choose to 
pre-issue purchase order numbers, you must 
pre-issue them to all buyers. 

I have orders that I place every month from 
certain vendors and I want to decrease my 
entry time.

You might consider setting up recurring 
purchase orders to decrease your entry time. 
Refer to “Creating a Recurring Purchase Order” 
on page 79 for more information on setting up 
and working with recurring orders.
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Monitoring productivity is very important for many businesses. In Purchase Order, you 

have some reports that can help monitor your ordering/receiving progress. These 

report include tracking late, expected, or received items or purchase history from 

vendors. Refer to this chapter for the various reports available and the sort and filter 

options for each report.

Reporting Overview
Reports and financial statements are the lifeblood of any good accounting system because they provide 
a snapshot of your business. Reports throughout Denali provide specific business information to help 
you make the right decisions for your organization.
Denali provides a wealth of reports applicable to the needs of any business. Yet any report is only as 
good as the information it is reporting. For this reason, it is very important to consider what kind of 
information you will need on your reports when you set up your accounting system. Once you enter the 
information into the database, you can retrieve and use the data in a variety of ways in the available 
reports. You can also sort or filter these reports to show only the information you want to see. You can 
use Crystal Reports to customize the look of your reports, and in some cases, the data it displays. This 
chapter contains samples of the reports and financial statements available in Denali.

Denali Reports Available
When you need specific information on the status of your business, you will need reports and financial 
statements. All Denali reports fall under one of three categories: financial statements, history reports, 
and control reports. Each report type serves a specific purpose and understanding each purpose will 
help make it easier to sort through the report options and determine which reports you need. This 
section gives an overview of the types of reports and statements available throughout Denali as well as 
in each different module. Depending on the modules you purchased and installed, options might appear 
differently or not at all.

Financial Statements
This type of report reflects the status of the business. These reports are used to view profits, losses, 
revenue/income, and expenses for the business. Two examples are the Trial Balance and Balance 
Sheet in the General Ledger module.

History Reports
This type of report provides a quick view of all the information entered in a module for a certain period. 
In other words, it is a transaction log. For instance, in the Inventory module, the History Report reflects 
all additions and subtractions to each individual stock item for the specified range. The Audit Trail is an 
example of a General Ledger history report.

NOTE:  Depending on how your print options were set up in the Module Preferences 
window, when you click OK, a message box might appear to notify you that the 
report is being processed. Do not close the window until the process is complete; 
doing so can cause problems in your system.
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Control Reports
You would use this type of report to verify the integrity of your data tables. These reports compare the 
master total to detail or period totals and show any discrepancies. For example, in the Accounts Payable 
module, the Control Report compares the total due for open invoices to the line detail for each vendor. 
If there is a discrepancy, an error report is automatically generated for you to use to correct the errors.
   

Reporting Options in Denali
Denali uses the information gathered in each module to create reports that can show you the 
information you need to make good business decisions. To increase the flexibility of these reports, 
Denali has a number of report options that allow you to fine tune your reports to meet your needs. The 
following options are available in most reports; some reports have additional options unique to them.

Options for Report Type
These options describe the different levels of detail available within some reports. Some of these 
options will only appear depending on the type of report you choose and the modules you have installed.

• Detailed: Shows all activity for a specified range.
• Condensed: Shows the group totals for a specified range.
• Summary: Shows one total for a specified range.
• Detailed with Notes: Shows all activity for a specified range along with any notes entered.
• Classified: Sorts by account class subcategories (report groups).
• Comparative Detailed: Lists all activity for both the selected year and the year prior to it. (Certain 

reports will show two years prior to the selected year.)
• Comparative Classified: Sorts by account class subcategories (report groups) for both the 

selected year and the year prior to it. (Certain reports will show two years prior to the selected 
year.)

Standard Report Sort Options
Some of the reports include a Sort By option, which offers choices of how the report information should 
be sorted. For example, in the Accounts Receivable module, you can sort by customer name or 
Salesperson Code.

Report Query Options
To enhance reporting capabilities, Denali includes querying functionality in several of the reports. This 
query ability allows you to report information based on specified search criteria. Keep in mind that 
depending on the integration settings for the module, some query options might appear differently or be 
unavailable. Refer to “Purchase Order Relationship with Other Modules” on page 23 for more 
information on how your integration settings might affect the query ability for reports.
In the report window, the fields on the Search For tab provide a means to further define your report 
query. For example, in the GL Audit Trail Report window the Search For fields have the options of 
Amount, Batch Number, User ID, or Module. One way to search for specific Batch Number information 
for this report is to select contains from the operand (query option) drop-down list and enter a portion of 
the batch information. Depending on the report, different search options are available.
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The query fields (comparison operator) have the options of equal to, not equal to, greater than, greater 
than or equal to, less than, less than or equal to, and contains. The information in this table explains the 
differences of each query option (operand).  

Once you select the search for option(s) and desired comparison operator(s), enter the amount to use 
for comparison. If you leave the criteria fields blank, the report will not appear with the enhanced query 
data. If the report does not provide the information you’re looking for, you can select the Reset button 
to reset the query options to the default settings and try different query parameters. 

Using the Search Feature in Lookups
You can reduce the amount of time it takes to locate a record by typing one or two characters of the 
record name or description in the Search box. The window automatically changes to display the section 
of the Lookup that contains the characters you type. For more information, refer to the Getting Started 
guide.

Selecting Dates from the Online Calendar
Denali makes it easy to enter dates when you set report criteria. When you see a date box, you can 
either type the date using the 10-digit format that includes separators, mm/dd/yyyy (e.g., December 10, 
2017 = 12/10/2017), or you can click the drop-down to open a calendar from which to select the date. 
For more information, refer to the Getting Started guide.

Working with Date Ranges
This date range feature is available for several of the reports in Denali and can increase the speed of 
reporting. You can select a specific date range with one click. The image of the AR History Report 
window in this section illustrates the Date Range drop-down list, from which you can choose one of the 
predefined ranges for the report.

Operand Field 

equal to The information returned is equal to the entered value or the selected 
field’s value.

not equal to The information returned is not equal to the entered value or the 
selected field’s value.

greater than The information returned is greater than the entered value or the 
selected field’s value.

greater than or equal to The information returned is greater than or equal to the entered value or 
the selected field’s value.

less than The information returned is less than the entered value or the selected 
field’s value.

less than or equal to The information returned is less than or equal to the entered value or the 
selected field’s value.

contains The information returned contains the information in the Search For 
field.
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Figure 67: AR History Report window, Date Range option

There are several predefined date ranges available and the table in this section provides an overview 
of each one.

Date Range Option Start Date for Report End Date for Report 

All The start date of the Fiscal Calendar. The current Denali date.

Today The current Denali date. The current Denali date.

This Week The date of the Sunday immediately 
preceding or equal to the current Denali 
date.

The date of the Saturday 
immediately following or equal 
to the current Denali date.

This Week to date The date of the Sunday immediately 
preceding or equal to the current Denali 
date.

The current Denali date.

This Month The first day of the month containing the 
current Denali date.

The last day of the month 
containing the current Denali 
date.

This Month to date The first day of the month containing the 
current Denali date.

The current Denali date.

This Fiscal Quarter The first date of the fiscal quarter 
containing the current Denali date.

The last date of the fiscal 
quarter containing the current 
Denali date.

This Fiscal Quarter to 
date

The first date of the fiscal quarter 
containing the current Denali date.

The current Denali date.

This Fiscal Year The first date of the fiscal year containing 
the current Denali date.

The last date of the fiscal year 
containing the current Denali 
date.

This Fiscal Year to date The first date of the fiscal year containing 
the current Denali date.

The current Denali date.
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Yesterday The date immediately preceding the 
current Denali date.

The date immediately 
preceding the current Denali 
date.

Last Week The date of the Sunday immediately 
preceding the week containing the current 
Denali date.

The date of the Saturday 
immediately preceding the 
week containing the current 
Denali date.

Last Week to date The date of the Sunday immediately 
preceding the week containing the current 
Denali date.

The current Denali date.

Last Month The first day of the month immediately 
preceding the month containing the 
current Denali date.

The last day of the month 
immediately preceding the 
month containing the current 
Denali date.

Last Month to date The first day of the month immediately 
preceding the month containing the 
current Denali date.

The current Denali date.

Last Fiscal Quarter The first day of the fiscal quarter 
immediately preceding the fiscal quarter 
containing the current Denali date.

The last day of the fiscal 
quarter immediately preceding 
the fiscal quarter containing 
the current Denali date.

Last Fiscal Quarter to 
date

The first day of the fiscal quarter 
immediately preceding the fiscal quarter 
containing the current Denali date.

The current Denali date.

Last Fiscal Year The first day of the fiscal year immediately 
preceding the fiscal year containing the 
current Denali date.

The last day of the fiscal year 
immediately preceding the 
fiscal year containing the 
current Denali date.

Last Fiscal Year to date The first day of the fiscal year immediately 
preceding the fiscal year containing the 
current Denali date.

The current Denali date.

Next Week The date of the Sunday immediately 
following the week containing the current 
Denali date.

The date of the Saturday 
immediately following the 
week containing the current 
Denali date.

Next 4 Weeks The date of the Sunday immediately 
following the week containing the current 
Denali date.

The date of the Saturday of the 
4th week following the week 
containing the current Denali 
date.

Next Month The first day of the month immediately 
following the month containing the current 
Denali date.

The last day of the month 
immediately following the 
month containing the current 
Denali date.

Date Range Option  Start Date for Report  (Continued) End Date for Report  
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Filter Ranges and Filter Methods
Fields are available to set beginning (Start) and ending (End) ranges to filter the information you will 
include in the reports or financial statements.
Methods for defining filter ranges are as follows:

• Start/End: Start and End are the defaults for most of the filter boxes. If you accept the default of 
Start in the Start box and End in the End box, all values for that item are included in the report.
You can also type the criteria in the Start and End boxes. When you enter a specific criterion in 
the Start box, the End box will auto-fill with the same criterion. 

• In any box where your mouse pointer appears as a magnifying glass, you can double-click to 
open a Lookup from which you can select the entry. Highlight the desired item, then choose 
Select.

• You can also apply additional filters using the Additional Filter box. These filters include any 
User-Defined Fields you set up (see “Tracking User-Defined Order Information” on page 25).

Another filtering method is based on the types of transactions available. For instance, you can choose 
to run a report that only includes invoices, receipts, or credit adjustments.

Purchase Order Reports
Purchase Order reports provide information about items you ordered, when they are expected, and the 
vendors you ordered them from. This section provides summaries of the different reports you can run 
in Purchase Order. A sample of each report is included; you might need to choose different options in 
the report windows to get the exact information you need. 

Open Purchase Order Report
If you want to view all open purchase orders, including those that have been received and invoiced, you 
can run the Open Purchase Order Report. All purchase orders that are not marked complete or purged 
from the system are considered open.

Next Fiscal Quarter The first day of the fiscal quarter 
immediately following the fiscal quarter 
containing the current Denali date.

The last day of the fiscal 
quarter immediately following 
the fiscal quarter containing 
the current Denali date.

Next Fiscal Year The first day of the fiscal year immediately 
following the fiscal year containing the 
current Denali date.

The last day of the fiscal year 
immediately following the 
fiscal year containing the 
current Denali date.

Date Range Option  Start Date for Report  (Continued) End Date for Report  
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Figure 68: PO Open Purchase Order Report

Requisition Report
If you want to view your requisitions, including those that have been approved, you can run the 
Requisition Report. You can choose from several sort and filter options to tailor the report to your needs. 
This report gives you all the information you would find on the Open Purchase Order Report. 

Figure 69: PO Requisition Report
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Expected/Late Items Report
On this report, you can view items that are expected to arrive by a certain date or are past the date you 
expected them. You can choose to view all items that you are expecting or only items that are late. This 
provides a method for you to track the arrival dates for your orders and follow up on late shipments. 

Figure 70: PO Expected Items Report

Vendor Performance Report
The Vendor Performance Report shows detailed information about the variance between information 
entered on the purchase order and the actual values after the order was received from the vendor. For 
example, you can view the estimated costs, expected dates, and quantities of the items ordered 
compared to the actual costs, dates received, and quantities received. This lets you compare vendors 
to ensure you are ordering from the vendor that best meets your needs. This report does not display 
direct expense line items.
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Figure 71: PO Vendor Performance Report

History Report
Use the History Report to view the history of items ordered through Purchase Order. You can view 
completed, partially received, or deleted purchase orders.

Figure 72: PO Purchase Order History Report

Recurring Purchase Order Report
If you want to view all or just some of the recurring orders that you set up, you can run the PO Recurring 
Purchase Order Report. In the PO Set Up Recurring Purchase Orders window, select the Print 
Report button from the window or the Options slide-out menu. For information on setting up recurring 
orders, see “Creating a Recurring Purchase Order” on page 79.
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Figure 73: PO Recurring Purchase Order Report

Generating a List of Pre-issued Purchase Order 
Numbers
If you want to see a list of pre-issued purchase order numbers, you can run the Pre-issue Purchase 
Orders Report. To run this report, select Options > View a List of Pre-issued Purchase Orders from 
the navigation pane and in the window that appears, select the List radio button. You can then sort the 
report by PO Number, Buyer, or Vendor. 

Figure 74: PO Pre-Issue Purchase Orders Report
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Printing Purchase Orders and Requisitions
You can print purchase orders and requisitions after you save them or you can print them individually 
as you go. You can also reprint orders that were previously printed. To print purchase orders as you 
enter each one, see “Printing a Purchase Order” on page 50. To print requisitions as you enter each 
one, see “Printing Requisitions” on page 61.
If you defined a custom report for this window in Controller, you can select the Use a custom report 
check box and then choose the custom report you want to run from the drop-down. See the Controller 
guide for more information on setting up custom reports.
You can add fields to preprinted purchase orders through Crystal Reports®. See the Crystal Reports 
documentation for information on how to do this. 
To print purchase orders and requisitions:

1 Select Purchasing Tasks > Print Purchase Orders from the left navigation pane.
- or -
If you’re in the Entry window, select Print Any PO from the Options slide-out menu. 
The PO Print Purchase Orders/Requisitions window will open. 

Figure 75: PO Print Purchase Orders/Requisitions window

2 From the Type drop-down, select if you want to print purchase orders or requisitions.
3 If you are printing purchase orders, select if you want to print orders from the open batch or the history 

batch. Requisitions only print from the open batch (approved requisitions become purchase orders). 
4 If you are printing from the open batch, choose from the Print Status drop-down whether you want to 

print previously printed, not yet printed, or all orders.
5 From the PO Format drop-down, choose if you want to print the orders on plain paper or use 

preprinted forms. 
6 Use the filter ranges to define the orders you want to print. 
7 When you are ready to print, click OK.

For detailed information about the options in this window, click the Help button. 
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Troubleshooting: Working with Reports in Purchase 
Order

At times, problems or errors can occur that are simple to fix without contacting Customer Support. Here, 
we indicate some common problems and ways to correct them. If you do not find what you are looking 
for in this section, refer to the help options under the “Denali Help” section of this guide and/or check 
the Documentation section of our Customer Service Center at https://service.cougarmtn.com/
documentation/ before you contact Customer Support. If you would like to offer suggestions for 
additions to our Troubleshooting sections, please email us at documentation@cougarmtn.com. 
 

To Fix This: Try This:

When I try to print a report, it continually goes 
straight to the printer, but I want to view it first.

You need to modify the module preferences 
settings for printing. Select Options > Set up 
the Module Preferences from the navigation 
pane. On the Print Options tab, make sure 
the Edit check box is checked. This allows you 
to select from sending the print job to the 
printer, to a file, or viewing it on the screen.
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Because there are many different tasks that buyers complete when they enter and 

receive purchase orders, it can be helpful to know shortcuts and quick entry options in 

the entry windows.

Shortcut Keys
These are the various shortcut keys that are available with the Purchase Order module in Denali. Some 
of the shortcuts are also used in other modules, but the following information is tailored to the 
purchasing and receiving processes. If all modules are not installed and integrated, some options might 
not be available.

Window Navigation: Purchasing
You can use these shortcut keys to quickly move throughout the purchasing window. 

Purchasing Shortcuts
The shortcut keys in this table provide a quick way to enter various aspects of the transaction. The 
shortcuts are organized according to their location in the PO Enter Purchase Orders or PO Set Up 
Recurring Purchase Orders window and which box/field the cursor is in.
You can also use the right-click button on your mouse to bring up a menu that contains many of the most 
commonly-used functions, including adding items, comments, and discounts to your transaction (see 
“Right-Click Menu for Purchasing” on page 103). 

Navigate To Shortcut Keys

PO # / Recurring PO # F5

Vendor / Shipping Information SHIFT + F6

Ship To Button ALT + S

Header Information SHIFT + F5

Detail Information SHIFT + F4

To Shortcut Key

Retrieve a purchase order or recurring order CTRL + P

Open the Purchase Order Lookup in the header section F5

Create a new purchase order or recurring order CTRL + N

Log Off/On Buyer CTRL + L

Access the online help ALT + H or F1

Open the Inventory Lookup in the detail grid and set the line 
type to Inventory

F5
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Right-Click Menu for Purchasing
When you work with items in the detail section of the window, you can use the right-click menu to 
expedite certain tasks. Place the mouse over the line item with which you want to work and right-click. 
On the menu that appears, there are several options from which to choose specific to purchasing items. 

Open the PO Comment Codes window and add a comment ALT + F5

Open the PO Enter Purchase Order Comments window and 
add/modify a comment

ALT + F6

Set the line type in the detail grid to Direct Expense and open 
the GL Master Lookup

ATL + F7

Delete the current purchase order or recurring order CTRL + D

Print the current purchase order or recurring order CTRL + Y

Save the current purchase order or recurring order CTRL + S

Exit the entry window CTRL + X

Menu Option Function

Insert Inventory Item This option inserts an inventory-type line item above the detail 
line from which the menu was accessed. Then the IN 
Available Inventory Lookup window opens from which you 
can select the stock item to add to the purchase order.

Insert Direct Expense Item This option inserts a direct expense-type line item above the 
detail line from which the menu was accessed. Then the GL 
Account Lookup window opens from which you can select the 
general ledger account to add to the purchase order.

Insert Blank Line This option inserts a blank line item above the detail line from 
which the menu was accessed.

Edit Comment This option is only available when you click on a comment-type 
line item and it opens the PO Enter Purchase Order 
Comments window in which you can edit the selected 
comment.

Delete Comment This option is only available when you click on a comment-type 
line item and it deletes the selected comment.

Insert Comment This option opens the PO Enter Purchase Order Comments 
window in which you can enter a new comment.

Insert Comment Code This option opens the PO Comment Codes Lookup window 
from which you can select a predefined Comment Code to add 
to the purchase order.

Cut Row This option is only available when you click on a detail line 
containing content and it removes the line from the purchase 
order and stores it in the clipboard to paste.

To Shortcut Key



104Quick Access in Purchase Order
Shortcut Keys

Window Navigation: Receiving
You can use these shortcut keys to quickly move through the receiving window.  

Receiving Transactions
The shortcut keys indicated in this table provide a quick way to enter the various aspects of the 
transaction. The shortcuts are organized according to their location in the PO Receive Items window 
and which box/field the cursor is in.
You can also use the right-click button on your mouse to bring up a menu that contains many of the most 
commonly-used functions, including adding items, comments, and discounts to your transaction (see 
“Right-Click Menu for Receiving” on page 105).

Copy Row This option is only available when you click on a detail line 
containing content and it copies the line and stores it in the 
clipboard to paste.

Paste Row This option is available when you click on any detail line (with 
content or blank) and it pastes the content from the clipboard 
into the purchase order.

Delete Row This option is only available when you click on a detail line 
containing content and it removes the line from the purchase 
order and the content cannot be recovered.

Save and Print Purchase Order This option saves the current purchase order, and then opens 
the PO Print/Reprint Purchase Orders window from which 
you can print the current purchase order.

Save Purchase Order This option saves the current purchase order, and then 
refreshes the window so you can enter another order.

Navigate To Shortcut Keys

Receiving Information SHIFT + F5

Detail Information SHIFT + F4

Invoice Information SHIFT + F2

Estimated Landing Information SHIFT + F3

Print Labels Button CTRL + R

Print Edit Report Button CTRL + P

To Shortcut Key

Retrieve transaction CTRL + T

Open the Purchase Order Lookup F5

Create a new receiving transaction CTRL + N

Menu Option Function
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Right-Click Menu for Receiving
When you work with items in the detail section of the window, you can use the right-click menu to 
expedite certain tasks. Place the mouse over the line item with which you want to work and right-click. 
On the menu that appears, there are several options from which to choose specific to receiving and/or 
invoicing items.
Depending on the transaction type you select in this window, some options might be disabled. Also, 
depending on the remaining quantity to receive or invoice, certain options are not applicable and are 
unavailable. 

Log Off/On Buyer CTRL + L

Access the online help ALT + H or F1

Delete the current receiving transaction CTRL + D

Print stock item labels CTRL + R

Print the Receiving Edit Report for the items in the current 
batch

CTRL + P

Save the current receiving transaction CTRL + S

Exit the receiving window CTRL + X

Menu Option Function

Receive All This option zeros out the Quantity Remaining field for the 
selected line item in the purchase order and adds the 
remaining quantity to the Quantity Received/Returned field.

Receive None This option zeros out the Quantity Received/Returned field 
for the selected line item in the purchase order and adds the 
amount to the Quantity Remaining field.

Invoice All This option zeros out the Received and Not Invoiced field for 
the selected line item in the purchase order and adds the 
amount to the Quantity to Invoice field.

Invoice None This option zeros out the Quantity to Invoice field for the 
selected line item in the purchase order and adds the amount 
to the Received and Not Invoiced field.

Reset Line Item This option zeros out the Quantity Received/Returned field 
for the selected line item in the purchase order and adds the 
amount to the Quantity Remaining field. Also, this option 
zeros out the Quantity to Invoice field for the selected line 
item and adds the amount to the Received and Not Invoiced 
field.

Edit Serial Numbers This option is only available when the menu is accessed for a 
serialized inventory line item. This option opens the PO 
Receive Serialized Items window in which you can assign or 
remove serialized items from inventory.

To Shortcut Key
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Quick Access Bar
This bar is located on the left-hand side of the PO Enter Purchase Orders, PO Set Up Recurring 
Purchase Orders, and PO Receive Items windows. Many of the features used during transaction entry 
can be accessed from this bar. When you click on one of the bar options, a slide-out menu appears with 
various choices. You can keep a slide-out open by clicking on the pin, or thumbtack, button. When you 
are finished with the slide-out, you can close it by clicking the X. The information in this section assumes 
all modules are installed and integrated. If this is not the case, some options might not be available.

Quick Access Options
The options on this slide-out menu change depending on whether you are in the PO Enter Purchase 
Orders, PO Enter Requisitions, PO Set Up Recurring Purchase Orders, or PO Receive Items windows. 
The slide-out contains various options for handling the transaction as well as setting up the layout or 
printing a purchase order. Also, some options are only available after you select a purchase order with 
which to work. 

Menu Button Function

This button opens the PO Recurring Purchase Order 
Lookup window from which you can select a purchase order 
to generate.

This button deletes the currently open purchase order from the 
system, provided you have security rights to do so. If you are 
in the recurring batch, this button reads Delete Recurring.

This button is accessed from the Receive Items window and 
deletes the currently open transaction from the system. The 
purchase order will still be available in the last saved state. 

This button is accessed from the Receive Items window and 
cancels any remaining items on the purchase order and marks 
it as complete. Items that were previously received and posted 
will remain in Inventory. 

This button opens the PO Change Local Transaction Date 
window in which you can modify the current date used for the 
Purchase Order module only.

This button opens the PO Set Up Purchasing/Receiving 
Layout window through which you can set up or modify the 
layout of the entry windows. You can modify any layout code, 
but you will only see changes to the layout you are currently 
logged in with. 

This button saves the currently open purchase order and 
refreshes the window so that you can enter another order. If 
you have a recurring order in view, this button reads Save 
Recurring.
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Quick Access History
The options on this slide-out menu change depending on whether you are in the PO Enter Purchase 
Orders or PO Set Up Recurring Purchase Orders windows and only appear if Accounts Payable and 
Purchase Order are integrated and a vendor is selected. The slide-out contains options to view different 
aspects of history for the selected vendor.  

This button opens the PO Print / Reprint Purchase Orders 
window through which you can print/reprint a single purchase 
order or range of orders.

This button opens the PO Receiving Edit Report or PO 
Purchasing Edit Report window defaulted to the information 
for the current batch.

This button opens the PO Receiving Labels window defaulted 
to the information for the selected receiving transaction. This 
button is only available if Inventory is installed and integrated 
with Purchase Order. It is not available for Invoice Only 
transaction types.

This button opens the PO Receiving Report window defaulted 
to the information for the current batch.

Menu Button To View

This button displays the selected vendor’s financial information 
in the upper section of the window. 

This button opens the PO Purchase History window in which 
you can view past purchases from the selected vendor and 
choose to add them to the current order.

This button opens the PO Vendor Transaction History 
window in which you can view a running transaction history for 
the selected vendor.

Menu Button Function
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Quick Access Notes
You can use the options on this slide-out menu to view or include various information about a vendor, 
purchase order, or stock item. This might be important if, for instance, you have a stock item that is 
continually on back order from the selected vendor. In the Inventory notes, you could indicate this 
information to alert management. 

Quick Access Picture
Depending on how the system is set up, you might have the option to view pictures of stock items.

The button on this slide-out opens the IN Image Viewer window which displays a larger view of the 
stock item selected in the detail grid. This option is only available if the stock item has a picture 
associated with it. 

Menu Button To View or Enter

This radio button shows any existing notes for the selected 
purchase order and allows you to add or edit a note.

This radio button shows any existing notes for the selected 
vendor and allows you to add or edit a note. This option is only 
available if integrated to Accounts Payable.

 This radio button shows any existing notes for selected line 
item and allows you to add or edit a note. This option is only 
available if integrated to Inventory.

 This button adds the time to the note that includes the hour, 
minute, and second.

This button opens the PO Search Notes window through 
which you can search existing notes.

This button allows you search for all occurrences of the 
selected text in existing notes.
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These additional resources are provided to better aid you with issues that might occur 

in Denali. Refer to the sections in this chapter for explanations of the detailed 

calculations and how to format user-defined fields. 

Purchase Order Calculations
This section provides detailed explanations of the calculations used in the various fields in the PO Enter 
Purchase Orders and PO Receive Items windows. These calculations work behind the scenes and are 
complex in nature. Because of this, we provide this information as a troubleshooting aid when you have 
a figure that appears incorrect when in a purchase order.

Entering Calculations: Subtotals/Totals Fields
The table in this section reflects the fields in the Totals section of the PO Enter Purchase Orders window 
that use calculations. For information on using the fields in the entering window, select the Help button. 

Receiving Calculations: Detail Fields
The table in this section reflects the fields in the Detail Information section of the PO Receive Items 
window that use calculations. For information on using the fields in the receiving window, select the Help 
button.  

Detail Field Calculation Used

Subtotal Sum of all Extended detail fields for Inventory and Direct Expense line 
types

Total Tax Sum of the sales tax for all detail lines with the Taxable check box 
checked

Total Discount If a Percent discount: (Extended sum for all discountable line items) * 
(Discount Amt)

If a Dollar discount: equals the amount in the Discount Amt field

Total Freight Equals the amount in the Freight Amt field 

PO Total Subtotal - Total Discount + Total Tax + Total Freight

Detail Field Calculation Used

Extended Invoice Qty Invoiced * Actual Cost of the line item

Inv. Unit Discount Inv. Ext. Discount / Quantity to Invoice
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Inv. Ext. Discount If a Percent discount and the Purchase Discount field in the 
Invoice Information section is unedited: (Extended Invoice 
amount for the line item) * (Discount Amt percentage from the 
original purchase order) 

If a Dollar discount or if recalculating after the Purchase 
Discount field in the Invoice Information section is edited: 
(Extended Invoice / Extended Invoice subtotal of all items with 
the Discount check box checked) * (Purchase Discount) 

Inv. Unit Tax Inv. Ext. Tax / Quantity to Invoice

Inv. Ext. Tax If the Tax field in the Invoice Information section is unedited: 
(Extended Invoice - Inv. Ext. Discount) * Sales Tax % from the 
original purchase order

If the Tax field in the Invoice Information section is edited: 
(Extended Invoice - Inv. Ext. Discount / ((Extended Invoice 
subtotal of all items with the Taxable check box checked)-(Inv. 
Ext. Discount subtotal of all items)) * (Tax field in the Invoice 
Information section) 

Inv. Unit Freight Inv. Ext. Freight / Quantity to Invoice

Inv. Ext. Freight (Extended Invoice / Extended Invoice subtotal of all items with 
the Apply Freight check box checked) * (Freight field in the 
Invoice Information section) 

Extended Receive For Receive Only transactions: Quantity Received/Returned of 
the line item * Estimated Actual Cost of the line item

For Receive and Invoice transactions: Quantity Received/
Returned of the line item * Actual Cost of the line item 

Land Unit Tax Land Ext. Tax / Quantity Received/Returned

Land Ext. Tax If the Landed Tax field in the Estimated Landing Information 
section is unedited): (Extended Receive - Land Ext. Discount) * 
Sales Tax % from the original purchase order.

If the Landed Tax field in the Estimated Landing Information 
section is edited: ((Extended Receive - Land Ext. Discount) / 
((Extended Receive sum of all items with the Taxable and the 
Land Item fields checked in the original purchase order) - (Land 
Ext. Discount subtotal of all items)) * (Landed Tax field in the 
Estimated Landing Information section)) 

Land Unit Discount Land Ext. Discount / Quantity Received/Returned

Detail Field Calculation Used
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Land Ext. Discount If a Percent discount and the Landed Purchase Discount field 
in the Estimated Landing Information section is unedited: 
(Extended Receive amount for the line item) * (Discount Amt 
percentage for the original purchase order) 

If a Dollar discount or if recalculating after the Landed 
Purchase Discount field in the Estimated Landing 
Information section is edited: (Extended Receive / Extended 
Receive subtotal of all items with the Discount check box 
checked) * (Landed Purchase Discount field in the Estimated 
Landing Information section) 

Land Unit Freight Land Ext. Freight / Quantity Received/Returned

Land Ext. Freight (Extended Receive / Extended Receive sum of all items with the 
Apply Freight and Land Item fields checked in the original 
purchase order) * (Landed Freight field in the Estimated 
Landing Information section)

Landed Unit Cost Landed Ext. Cost / Quantity Received/Returned

Landed Ext. Cost Extended Receive + Land Ext. Tax - Land Ext. Discount + Land 
Ext. Freight

Detail Field Calculation Used
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Receiving Calculations: Landing Fields
The table in this section reflects the fields in the Estimated Landing Information section of the PO 
Receive Items window that use calculations. For information on using the fields in the receiving window, 
select the Help button.  

Landing Field Calculation Used

Landed Purchase Discount If a Percent discount, then the Land Ext. Discount sum for all 
discountable line items with Land Item checked shows in this 
field

If a Dollar discount, then one of these three outcomes occurs:

• If B is less than or equal to zero, then the 
Landed Purchase Discount is zero

• If A is less than B, then the Landed Purchase 
Discount equal A

• If A is greater than B, then the Landed 
Purchase Discount equals B

A = (Extended Receive sum for all discountable line items with 
Land Item checked) / (Sum for all discountable line items with 
Land Item checked ((Quantity Received/Returned + Quantity 
Remaining + Quantity already posted) * (Estimated Actual or 
Actual Cost))) * (Discount Amt field from the original purchase 
order)

B = (Discount Amt field from the original purchase order) - Total 
Landed Purchase Discount already posted for the purchase 
order) 

Landed Tax (Extended Receive sum for all Taxable line items with Land 
Item checked) - (Extended Discount sum for all Discountable 
line items with Discount checked) * (Sale Tax% from original 
purchase order)

Landed Freight Depending on the amount, one of these three outcomes occurs:

• If B is less than or equal to zero, then the 
Landed Freight is zero

• If A is less than B, then the Landed Freight 
equal A

• If A is greater than B, then the Landed Freight 
equals B

A = (Extended Receive sum for all discountable line items with 
Land Item checked) / (Sum for all discountable line items with 
Land Item checked ((Quantity Received/Returned + Quantity 
Remaining + Quantity already posted) * (Estimated Actual or 
Actual Cost))) * (Freight Amt field from the original purchase 
order)

B = (Freight Amt field from the original purchase order) - (Total 
Landed Freight already posted for the purchase order) 
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Receiving Calculations: Invoicing Fields
The table in this section reflects the fields in the Invoice Information section of the PO Receive Items 
window that use calculations. For information on using the fields in the receiving window, select the Help 
button. 

Detail Field Calculation Used

Early Payment Discount (Subtotal - Total Discount) * (Discount percentage as defined in 
the AP Vendors window)

Purchase Discount If a Percent discount: (Extended Invoice sum for all discountable 
line items) * (Discount Amt percentage from the original 
purchase order) 

If a Dollar discount, one of these three outcomes occurs:

• If B is less than or equal to zero, then the 
Purchase Discount is zero

• If A is less than B, then the Purchase Discount 
equal A

• If A is greater than B, then the Purchase 
Discount equals B

A = (Extended Invoice sum for all discountable line items) / 
(Sum of all discountable line items (Received and Not Invoiced 
+ Quantity Invoiced + Quantity already invoiced) * (Actual 
Cost))) * (Discount Amt field from the original purchase order)

B = (Discount Amt field from the original purchase order) - Total 
Purchase Discount already posted for the purchase order)

Tax (Sales Tax %) * (Extended Invoice sum for all Taxable line items) 
- (Extended Discount sum for all Discountable line items)

Freight Depending on the amount, one of these three outcomes occurs:

• If B is less than or equal to zero, then the 
Freight is zero

• If A is less than B, then the Freight equal A
• If A is greater than B, then the Freight equals 

B
A = (Extended Invoice sum for all discountable line items) / 
(Sum for all discountable line items (Received and Not Invoiced 
+ Quantity Invoiced + Quantity already invoiced) * (Actual 
Cost))) * (Freight Amt field from the original purchase order)

B = (Freight Amt field from the original purchase order) - (Total 
Freight already posted for the purchase order) 
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Receiving Calculations: Subtotals/Totals Fields
The table in this section reflects the fields in the Totals section of the PO Receive Items window that 
use calculations. For information on using the fields in the receiving window, select the Help button. 

Formatting User-Defined Fields
To change the default of how a user-defined field is going to appear in the entry screens, you need to 
format it. Numeric fields allow a maximum of 11 digits with 4 decimals. Text fields have a default of 50 
characters (30 in Payroll), but can be modified by the number you enter in the Size field. Date fields 
allow caption entry only—the date format is already specified. The characters used to create user-
defined formats are listed in the table provided here. 

Detail Field Calculation Used

Subtotal If an Invoice Only or Receive and Invoice transaction: (Sum of 
all items (Quantity to Invoice * Actual Cost))

If Receive Only transaction: (Sum of all items (Extended 
Receive))

Invoice Total Subtotal - Total Discount + Total Tax + Total Freight

Receive Total Subtotal - Landed Discount + Landed Tax + Landed Freight

Formatting 
Character

Description Results

. (period) Decimal placeholder Determines how many digits are displayed to the left and 
right of the decimal separator. The actual character used is 
the one specified as the decimal placeholder in the 
international settings in the Control Panel. This character is 
treated as a literal for masking purposes.

, (comma) Thousand separator Separates thousands from hundreds within a number that 
has four or more places to the left of the decimal separator. 
The actual character used is the one specified as the 
thousands separator in the international settings in the 
Control Panel. This character is treated as a literal for 
masking purposes. 

: (colon) Time separator Separates time elements, such as hour:minute:second. The 
actual character used is the one specified as the time 
separator in the international settings in the Control Panel. 
This character is treated as a literal for masking purposes. 

/ (slash) Date separator Separates date elements such as day/month/year. The 
actual character used is the one specified as the date 
separator in the international settings in the Control Panel. 
This character is treated as a literal for masking purposes. 
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# Digit placeholder Displays a digit (0-9). For example, ####.## accepts 
1234.12.

A Alphanumeric 
placeholder

Displays an alphanumeric character (a-Z and 0-9) and is 
required.

? Alphabetic 
placeholder

Displays an alphabetic character (a-Z) and is optional.

> Alphabetic 
placeholder, but forces 
uppercase characters 
(A-Z)

All characters are displayed in uppercase format. 

< Alphabetic 
placeholder, but forces 
lowercase characters 
(a-z)

All characters are displayed in lowercase format.

& Character placeholder Valid values are ANSI characters in the following ranges: 
32-126 and 128-255 and is required. 

\ Displays the next 
character in the format 
string

Many characters in the format expression have a special 
meaning and can’t be displayed as literal characters unless 
they are preceded by a backslash. The backslash itself is 
not displayed. Note that two backslashes must be used in 
string literals to accommodate for the fact that this is also 
treated as an escape character for ANSI/ISO string 
formatting.

Formatting 
Character

Description Results
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Glossary

A
Accounting Period The period of time covered by an income statement. One year is often the 

accounting period for financial reporting, but financial statements are also pre-
pared by most organizations for each quarter and each month.

Accrual Basis of
Accounting

The practice of recording revenue in the period in which it is earned and recording 
expenses in the period in which they are incurred. The effect on the business is 
recognized as goods or services are rendered or consumed, rather than when 
cash is received or paid.

Applied Credit In Accounts Receivable, a credit memo that reduces the amount remaining to be 
paid on a specific debit item, instead of merely reducing the total amount owed on 
the account.

Applied Debit In Accounts Payable, a debit memo that reduces the amount remaining to be paid 
on a specific credit item, instead of merely reducing the total amount owed on the 
account.

Applied Payment In Accounts Receivable or Sales modules, a payment that reduces the amount 
remaining to be paid on a specific debit item, instead of merely reducing the total 
amount owed on the account.

AP Code A six-character alphanumeric code attached to vendor master records that directs 
how transactions are posted to General Ledger accounts and also how they are 
aged. 

AR Code A six-character alphanumeric code attached to customer master records and 
used to categorize customers. The AR Code is also used to specify a GL 
Accounts Receivable account.

Assets The economic resources owned by a business for the purpose of conducting busi-
ness operations.

Audit Trail The documentation of transactions for use by consumers and auditors of financial 
statements to substantiate the authenticity and accuracy of the financial state-
ments. Also, a report available in the General Ledger module that provides a 
chronological listing by account of the entries posted to each account.

B
Backups Periodically updated copies of computer data that ensure against total loss of data 

from a catastrophic event. Backups can be automatic or manual.

Balance Forward An AR customer type specified by the AR Code in which all open invoices are 
compacted into a single monthly balance at the end of each month. See also 
Open Item.
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Bank Reconcilia-
tion

A report, or the process of preparing it, that lists the outstanding items comprising 
the difference between the bank statement balance and the organization check-
book balance.

Batch Processing A transaction processing method that allows for multiple transactions to be 
entered and edited prior to posting. You can also choose to use one or multiple 
batches.

Batch Status The activity status associated with each batch of transactions. The status is view-
able through the Batch Status Report for modules set up for multiple batch pro-
cessing. You can access a batch until it is posted.

Batch Type Batch types are identified in the Batch Status Reports, with each type of batch 
containing different transaction types. The different modules have different batch 
types. 

Benefit Benefit earned by employee such as vacation leave, sick leave, insurance, bonus, 
etc. Benefits do not increase the amount of the employee’s paycheck.

C
CMS Date The CMS Date (or system date) is the date that all modules and software use by 

default. This date is set each time the software is opened.

Cash Basis of
Accounting

The practice of recording revenue when received in cash and recording expenses 
when they are paid in cash. 

Cash Flow State-
ment

A statement of sources of cash receipts and purpose of cash disbursements used 
to explain the change in the Cash account balance.

Cash Key An indicator that identifies a transaction as a cash transaction and determines 
which General Ledger Cash account is affected.

Chart of Accounts A list of the general ledger accounts and corresponding account numbers used to 
record the events of a business.

Committed In Inventory, the process of deducting the quantity of stock items that have been 
included in a transaction that has been saved but not posted from the available 
quantity of that stock item. Once the sales transaction has been posted, the com-
mitted quantity is subtracted from the on-hand quantity, the on-hand quantity is 
updated, and the committed quantity is reset to zero. For example, if there are 20 
widgets in stock and the clerk sells 4 over the course of the day, then the on-hand 
quantity of the item will still reflect 20, but the Available quantity (which is what 
appears when you open the stock item lookup when selling an item) will reflect 16, 
since 4 have been committed. Once the transactions for the day have been 
posted, the committed quantity is reset to zero, and the on-hand quantity is 
adjusted to 16, which will match the Available Quantity until more transactions 
which include that stock item are saved.

Consolidated Finan-
cial Statements

Financial statements presenting the combined financial position and operating 
results of affiliated organizations.
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Context-Sensitive
Help

Help that is relevant to the current active window. It includes information about all 
the options in the window. A Help button is available in some windows and the 
default Help key is F1. (See also the Task-based Help definition).

Contra Account A ledger account which is deducted from a related account. 

Contra-Asset
Account

An account with a credit balance that offsets an asset account to reflect the appro-
priate balance sheet value for the asset. 

Contra-Liability
Account

An account with a debit balance that offsets a liability account to reflect the appro-
priate balance sheet value for the asset.

Cost Activity In Job Cost, you enter cost activity to keep track of the progression of your jobs. 
Activity posts to all affected modules.

Cost Code In Job Cost, Cost Codes allow you to track activity and cost for specific parts of 
your jobs. They help you maintain accurate budgets, effective planning, and stay 
up-to-date on your projects.

Credit An amount entered in the right-hand column of a ledger account. A credit 
decreases an asset or expense account balance, and increases a liability, equity, 
or income account balance.

Credit Memo A document issued that reduces the amount of a receivable or increases the 
amount of a payable. These are used to record returned goods, defective goods 
or services, miscellaneous charges or credits, and error corrections.

D
Database For Denali, the database refers to the SQL server that stores the software tables. 

The tables store all of your organization data.

Debit A debit increases an asset or expense account balance, and decreases a liability, 
equity, or income account balance.

Deduction Amount deducted from pre-tax or after-tax wages.

Default A value automatically placed in a data entry field that is saved unless it’s overrid-
den to a different value.

Department Code A Code that defines the departments within an organization. Department Codes 
determine which general ledger income accounts are affected by transactions.

Detail Line Type The type of transaction item entered on a particular line of a transaction docu-
ment.

Discount Code A two-part code established in the Sales module which specifies a discount per-
centage by inventory item and customer. One half of the code is entered on the 
customer master record and the other half is entered as part of each Inventory 
master record.
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Double-Entry
Accounting System

A system in which the total dollar amount of debits must equal the total dollar 
amount of credits.

Due From An asset account that indicates the amount of deposits held in another account.

Due To A liability account that indicates the amount payable to another account.

E
Earnings Wages, salary, or other compensation.

Edit Report A listing of entered but not posted transactions for checking the accuracy of the 
data entry work.

EFT Electronic Funds Transfer. The electronic transfer of funds from one bank account 
to another in an encrypted format. Charges are made automatically through the 
Federal Reserve’s automated Clearing House (ACH).

EFTPS Electronic Federal Tax Payment System; must be used to make electronic tax 
payments to the IRS.

EIN Employer Identification Number; This number is distributed by the IRS and is your 
business identity; also called Tax Identification Number.

Electronic Con-
stants

Method of saving data in a report format to submit the report electronically, rather 
than on paper.

Encumber Setting aside an amount as a planned expense or obligation.

Equity See Owner’s Equity.

Expense The cost of goods or services used for the purpose of generating revenue.

Expense Allocation The process of allocating indirect expenses of a business among departments.

Extended Price The result when the quantity invoiced is multiplied by the price per unit. The total 
for a detail line on an invoice.

F
FICA Federal Insurance Contributions Act. The tax paid equally by employee and 

employer, commonly known as Social Security Tax.

FIFO Also known as “first in, first out”, this is an inventory valuation method based on 
the assumption that the first item acquired is the first item sold, and that the 
remaining items are the most recently acquired.

Finished Good A product that is created by combining other items. In Inventory, this is called a 
Kit. The Finished Good has completed the manufacturing and/or assembly pro-
cess and is ready for sale.
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Form 940 Employer’s Annual Federal Unemployment (FUTA) Tax Return.

Form 941 Employer’s Quarterly Federal Tax Return.

FUTA Federal Unemployment Tax (See Form 940).

G
GL Key Six-character alphanumeric entries found in various codes throughout the 

accounting modules that are used in the Interface Table to specify an associated 
general ledger account.

H
Hold Invoice A sales invoice that is retained in the batch for further action. A hold transaction 

remains in the hold batch and does not post until it is retrieved and changed to an 
invoice.

History Transactions that were posted in any module.

I
IN Code A six-character alphanumeric code attached to IN Stock master records that 

directs how transactions are posted to General Ledger accounts and the inventory 
valuation method. 

Income Revenue resulting from the operations of a business.

Interface Code It specifies which general ledger accounts are affected by a transaction. 

Interface Key Often used interchangeably with GL Key. See GL Key.

Interface Table A cumulative table of Interface Codes that directs posting of transactions from the 
Sales and Accounts Receivable modules to the appropriate general ledger 
accounts. It is similar to a Lookup table that contains every possible set of trans-
action circumstances and the accounts affected by transactions conducted under 
each set of circumstances.

Integration Indicators set within the Module Preferences window of each module that speci-
fies communication of posted information between modules.

Invoice Only Trans-
action

A Purchase Order transaction that invoices items that were previously received 
into Inventory but not invoiced.

Invoice An itemized statement of goods or services sold that shows quantities, prices, 
total charges, payment terms, and sales tax. An invoice might also include many 
other items of information such as item description. The invoice serves as the 
original evidence of ownership transfer for both the buyer and seller.
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J
Journal Entry This is a transaction created in General Ledger that adjusts particular accounts in 

your chart of accounts.

K
Kits This refers to a method of selling a group of inventory items for one price. For 

example you could create a pizza kit that might include the dough, sauce, and 
grated cheese. A kit is a group of stock items sold together as a single item.

L
Landing Cost The costs of acquiring inventory besides the purchase cost. Sales tax and freight 

charges can be landing costs. Discounts can also be considered landing costs 
depending on your business.

Liabilities The claims against the assets of a business. The debts or financial obligations of 
a business.

LIFO Also known as “last in, first out” and is an inventory valuation method based on 
the assumption that the last item acquired is the first item sold, and that the 
remaining items are the first acquired.

Line Item Types The different types of transactions that can be documented on a detail line of an 
invoice. 

M
Master Tables The tables that hold the records containing general information about the partici-

pants or objects of transactions within a module. In General Ledger the master 
table contains the account names, numbers, and balances. In Accounts Receiv-
able the master table contains the customer names, numbers, balances, and 
other general information. In Inventory the master table contains the inventory 
item descriptions, stock numbers, and cost and quantity information.

Module One of the functional applications of Denali. The modules are Controller, General 
Ledger, Accounts Receivable, Accounts Payable, Sales (Order Entry/Point of 
Sale), Inventory, Job Cost, Payroll, Purchase Order, and Bank Reconciliation. 

N
Nested Tax Codes A set of Sales Tax Codes that are set up to charge tax on a sale for more than one 

taxing agency. The total for all agencies is assessed on the sale, and the amounts 
for the individual agencies are recorded separately.

Non-Inventory Code A code that defines product categories that are not inventory items.
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O
Open Item A line item from a receivable or payable transaction that has an amount remaining 

to be paid or applied.

Other Time In Payroll, units worked at other than the regular pay rate, such as overtime units.

Outstanding
Checks

Checks issued on a bank account that have not been presented to the bank for 
payment.

Owner’s Equity The resources invested in a business by the owner plus profits retained in the 
business. The amount by which the assets of an organization exceed liabilities.

P
Paid Out In Accounts Payable, an invoice paid to a vendor that does not have a vendor 

record established in the AP module. In Purchase Order, an order made out to a 
vendor that does not have a vendor record established in the AP module. In the 
Sales module, a paid out transaction is one in which cash is removed from the 
drawer to fund a miscellaneous purchase. 

Periodic Occurring at regular time intervals.

Phase In Job Cost, phases are groups of Cost Codes that make up different parts of your 
jobs. As you complete phases, you enter cost activity.

Posting The process of recording the effects of transactions to other integrated modules 
and General Ledger. Posting creates a history of your transactions. 

Prepaid Expenses Expenses, such as rent and insurance, which are paid in advance. The unused 
portion of prepaid expenses are a balance sheet asset.

Profit The amount by which the revenue from business operations exceeds the cost of 
operations.

R
Recurring Batch A transaction batch that holds template invoices that can be generated repeat-

edly. It is used for periodically recurring transactions without having to retype the 
information each time. 

Retained Earnings The portion of owner or stockholder equity that is a result of profit earned by the 
business.

Revenue (Operat-
ing Credit)

Income that a business receives from its business operations.

S



124

G
l
o
s
s
a
r
y

Glossary
Purchase Order for Fund User’s Guide

SQL Structured Query Language. This is the type of database Denali uses.

Standard Cost An Inventory valuation method by which the cost assigned to an Inventory item at 
the time of sale is a predetermined estimate. When the actual cost is recognized, 
any variance between standard and actual costs is posted to an inventory vari-
ance account and an expense adjustment account.

T
Tax Number Also known as Tax Identification Number or EIN, this is the number assigned to 

your business by the IRS.

Terms Code A code in Accounts Receivable that outlines terms for early payment discounts 
and finance charges. When a Terms Code is attached to a transaction, the terms 
specified in the code apply to the transaction.

Transaction Batch A group of transactions that will be posted together.

Transactions Business events which can be measured in money.

U
Unapplied Credit A credit in Accounts Receivable or the Sales module that reduces the total 

amount owed by the customer, but does not reduce the amount remaining to be 
paid on a specific debit item. The unapplied item is an open item until the full 
amount is applied.

Unapplied Debit A debit in Accounts Payable that reduces the amount owed a vendor, but does not 
reduce the amount remaining to paid on a specific credit item. The unapplied item 
is an open item until the full amount is applied.

Unapplied Payment A payment in Accounts Receivable or the Sales module that reduces the total 
amount owed by the customer, but does not reduce the amount remaining to be 
paid on a specific debit item. The unapplied item is an open item until the full 
amount is applied.

Units The number by which the pay rate is multiplied to calculate gross pay. The most 
commonly used units in Payroll calculations are hours, but other measures of time 
or production can be used.

Universal Bridge The Denali feature that imports unposted transactions from an external file. Mod-
ules that support this feature are General Ledger, Accounts Receivable, Accounts 
Payable, Inventory, Sales, Payroll, and Bank Reconciliation.

User Interface The means by which a computer user exchanges information with the computer. 
The menu and data entry screens are good examples of user interface.

V
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Valuation Method The practice used to assign costs to inventory items sold.

W
W-2 Employee wage and tax statement, provided by the employer to the employee.

W-3 Transmittal of Wage and Tax Statements. Information filed with the Social Security 
Administration by the employer.

Weighted Average
Cost Method

This method of inventory valuation divides the total cost of stock items available to 
sell by the number of units available.

Window-Specific
Help

Help that is relevant to the current window. It includes information about all the 
options in the window. A Help button is available in some windows and the default 
Help key is F1.
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detail fields 110
invoicing fields 114
landing fields 113
subtotals/totals fields 110, 115

changing
codes 38
item on purchase order 47
requisition 61
vendor address 44

clearing
a purchase order 49
receiving transactions 72

code
buyer code 33
change or delete 38
comment code 34
department, setup 33
frequency, setup 36
layout 29
purchase order 32
ship via, setup 36
user-defined, setup 37

comment
entering in purchase order 48
setting up code 34

computer-assisted ordering 54
context sensitive help 12
correcting

errors in posted transactions 85
errors in unposted transactions 84

errors on edit report 84
creating

inventory items in purchase order 44
new layout code 29
recurring purchase order 79
requisitions 59

customer support 16
contacting 16
gathering information 16

customizing
fields, setting up 25
fields, setting up codes 37
window layouts 26

D
date

selecting, online calendar 91
default

setting in purchase order 24
settings, landing options 22

defining
detail information 31
header information 30
invoice information 31
landing information 31
vendor information 30

deleting
a purchase order 49
codes 38
item on purchase order 47

department code, set up 33
detail information, define 31
direct expense

enter on purchase order 47
discount

enter in purchase order 48
document conventions 11
drop ship, enter address on a purchase order 52

E
edit report, correct errors 84
editing a purchase order 54
editing requisitions 61
email alerts

add emails 39
sending 55, 62, 71

entering
a vendor 44
comments in purchase order 48
direct expense 47
discount in purchase order 48
drop ship address on a purchase order 52
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freight on a purchase order 48
items in a purchase order 44
paid out purchase order 51
purchase order from history 45
purchase order number 43
purchase orders, basic tasks 42
requisition 59
returns 77
window layout overview 26

entering calculations 110
entry tasks

advanced 51
basic 42

error
correcting on edit report 84
in posted transactions, correcting 85
in unposted transactions, correcting 84

expected late items report 96

F
field calculation 110

detail 110
invoicing 114
landing 113
subtotals/totals 110, 115

freight
charges 48
entering on purchase order 48

frequency codes, setup 36

G
generating

list of pre-issued purchase order numbers 98
purchase orders from inventory 54
recurring order 80

H
header information, define 30
help

customer support 16
task-based 12
troubleshooting options 18
user’s guide 15
window specific 12

history
add items to purchase order 45
entering purchase order from 45
purge in purchase order 86

I
internal alerts

manage emails 39

internal control alerts
sending 55, 62, 71

inventory
add to order 44
labels, print 73

invoice
information, define 31
purchase order 67

L
landing 22

costs, tracking 68
information, define 31

layout
code, creating new 29
code, modify 31
defining 26
entering window 26
receiving window 26
user-defined fields 28

list of pre-issued purchase order numbers 98
lookup

list 91
lot numbered items

receive 70

M
manage email alerts 39
modifying

a purchase order 54
existing layout 31
item on purchase order 47
layout code 31

N
navigation 102, 103, 104, 105, 106

O
online

calendar
selecting date from 91

purchase order numbering 24
training 17

open purchase order report 94
options

in purchase order 20
order number

enter 43
pre-issue 76

ordering
from history 45

overview
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entry window 26
receiving window 27

P
paid out purchase order 51
partially receiving a purchase order 66
post transactions 85
posted transactions, correcting errors 85
preferences

in purchase order 20
pre-issue

generate list of numbers 98
purchase order numbers 76

printing
a purchase order 50
code report 37
options in purchase order 24
purchasing edit report 82
receiving edit report 81
receiving report 83
requisitions 61
stock labels 73

printing in Purchase Order 26
printing purchase orders 99
printing requisitions 99
purchase order

add items in receiving window 68
add other items 47
change item 47
clear 49
codes 32
creating recurring 79
creating stock items 44
delete 49
delete item 47
edit 54
enter returns 77
general setup 20
generating from inventory 54
generating recurring 80
history

purging 86
history report 97
invoice 67
landing costs 68
number, enter 43
numbers, pre-issue 76
options 20
partially receive 66
preferences 20
print 50, 99
print a code report 37

receive all 65
receiving 65
relationship with other modules 23
reports 94

Purchase Order prining 26
purchasing

department codes, setup 33
edit report, print 82
shortcuts 102, 103

purging
purchase order history 86

Q
quick access bar 106
quick reference, shortcut keys 102

R
receiving

calculation 110
calculations 110, 113, 114, 115
clear transactions 72
edit report, print 81
layout window overview 27
lot numbered items 70
purchase order 65
report, print 83
serialized items 70
shortcuts 104, 105

recurring
purchase order report 97
purchase order,create 79
purchase order,generate 80

relationship with other modules 23
release notes 15
report

code 37
expected late items 96
open purchase order 94
purchase order 94
purchase order history 97
recurring purchase order 97
requisition 95
vendor performance 96

reports
options

date 90
filter 94
lookup 91
sort 90

overview 89
type 89
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classified 90
comparative classified 90
comparative detailed 90
condensed 90
control 90
detailed 90
detailed with notes 90
financial 89
history 89
options 90
summary 90

requisition
approve 60
create 59
edit 61
print 61

requisition report 95
requisitions

print 99
returning

items in purchase order 77
serialized items 78

review transactions 81
right-click menu 103, 105

S
screen layouts

defining 26
selecting

a buyer 42, 59
a vendor 44
date, online calendar 91

sending email alerts 55, 62, 71
serialized items

receive 70
returning 78

setting
batches 21
buyer codes 33
comment codes 34
customized fields 25
frequency codes 36
general preferences 20
landing 22
preferences 20
print options 24
purchase order defaults 24
screen layouts 26
ship via codes 36
user-defined codes 37
user-defined fields 25
users 33

setting printing preferences 26
sharing information between modules 23
shipping

setting up codes 36
shortcut keys 102, 104
sort

methods 94
stock items

add to order 44
not in lookup 44

stock labels, print 73

T
tracking

landing costs 68
training 16

classroom 17
online 17
on-site 17
telephone 17

transaction, review 81
transactions

clearing receiving 72
posting 85

transactions, batches 21
troubleshooting

entering purchase orders 57
entering requisitions 63
options 18
purchase order management tasks 87
receiving purchase orders 74
setting up module 40
working with reports 100

U
udf in entry window 28
udf in receiving window 28
user-defined

code setup 37
fields, setting up 25

user-defined fields 28
using this guide 10

V
vendor

information, define 30
information, view 52
performance report 96
select 44

viewing vendor information 52
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W
window specific help 12
working with batches 21
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